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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with this user’'s guide, may
cause harmful interference to radio communications. Operation of this equipment in a residential area is likely
to cause harmful interference in which case the user will be required to correct the interference at his own
expense.

Innovation, Science and Economic Development Canada (ISED) Statement
This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

VCCI-A Warning
COEREF. VIR ABHREMEETY., COREERERETHERAT S LEBREEESIER
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Japan Voluntary Control Council for Interference Statement

This is a Class A product based on the standard of the Voluntary Control Council for Interference (VCCI). If this
equipment is used in a domestic environment, radio interference may occur, in which case the user may be
required to take corrective actions.
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Warning:

This is a class A product. In a domestic environment this product may cause radio interference in which case
the user may be required to take adequate measures.
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CE Mark Warning

This equipment is compliant with Class A of CISPR 32. In a residential environment this equipment may cause
radio interference.

Warnung!

Dies ist ein Produkt der Klasse A. Im Wohnbereich kann dieses Produkt Funkstoerungen verursachen. In
diesem Fall kann vom Benutzer verlangt werden, angemessene Massnahmen zu ergreifen.

Precaucion!

Este es un producto de Clase A. En un entorno doméstico, puede causar interferencias de radio, en cuyo case,
puede requerirse al usuario para que adopte las medidas adecuadas.

Attention!

Ceci est un produit de classe A. Dans un environnement domestique, ce produit pourrait causer des
interférences radio, auquel cas I" utilisateur devrait prendre les mesures adéquates.

Attenzione!

Il presente prodotto appartiene alla classe A. Se utilizzato in ambiente domestico il prodotto pud causare
interferenze radio, nel cui caso & possibile che I'utente debba assumere provvedimenti adeguati.

SAFETY INSTRUCTIONS

The following general safety guidelines are provided to help ensure your own personal safety and protect your product
from potential damage. Remember to consult the product user instructions for more details.

« Static electricity can be harmful to electronic components. Discharge static electricity from your body (i.e. touching
grounded bare metal) before touching the product.

* Do not attempt to service the product and never disassemble the product. For some products with a user replaceable
battery, please read and follow the instructions in the user manual.

* Do not spill food or liquid on your product and never push any objects into the openings of your product.

» Do not use this product near water, areas with high humidity, or condensation unless the product is specifically rated for
outdoor application.

» Keep the product away from radiators and other heat sources.

* Always unplug the product from mains power before cleaning and use a dry lint free cloth only.

SICHERHEITSVORSCHRIFTEN

Die folgenden allgemeinen Sicherheitsvorschriften dienen als Hilfe zur Gewahrleistung Ihrer eigenen Sicherheit und zum
Schutz Ihres Produkts. Weitere Details finden Sie in den Benutzeranleitungen zum Produkt.

« Statische Elektrizitat kann elektronischen Komponenten schaden. Um Schaden durch statische Aufladung zu vermeiden,
leiten Sie elektrostatische Ladungen von lhrem Korper ab,

(z. B. durch Beruhren eines geerdeten blanken Metallteils), bevor Sie das Produkt berihren.

* Unterlassen Sie jeden Versuch, das Produkt zu warten, und versuchen Sie nicht, es in seine Bestandteile zu zerlegen.
Fur einige Produkte mit austauschbaren Akkus lesen Sie bitte das Benutzerhandbuch und befolgen Sie die dort
beschriebenen Anleitungen.

* Vermeiden Sie, dass Speisen oder Flissigkeiten auf lhr Produkt gelangen, und stecken Sie keine Gegenstinde in die
Gehauseschlitze oder -6ffnungen Ihres Produkts.

» Verwenden Sie dieses Produkt nicht in unmittelbarer Nahe von Wasser und nicht in Bereichen mit hoher Luftfeuchtigkeit
oder Kondensation, es sei denn, es ist speziell zur Nutzung in

AuRenbereichen vorgesehen und eingestuft.

* Halten Sie das Produkt von Heizkdrpern und anderen Quellen fern, die Warme erzeugen.

* Trennen Sie das Produkt immer von der Stromzufuhr, bevor Sie es reinigen und verwenden Sie dazu ausschlielich ein
trockenes fusselfreies Tuch.

CONSIGNES DE SECURITE

Les consignes générales de sécurité ci-aprés sont fournies afin d’assurer votre sécurité personnelle et de protéger le
produit d’éventuels dommages. Veuillez consulter les consignes d’utilisation du produit pour plus de détails.

« L’électricité statique peut endommager les composants électroniques. Déchargez I'électricité statique de votre corps (en
touchant un objet en métal relié a la terre par exemple) avant de toucher le produit.

* N’essayez pas d’intervenir sur le produit et ne le démontez jamais. Pour certains produits contenant une batterie
remplagable par l'utilisateur, veuillez lire et suivre les consignes

contenues dans le manuel d’utilisation.

* Ne renversez pas d’aliments ou de liquide sur le produit et n'insérez jamais d’objets dans les orifices.
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* N'utilisez pas ce produit a proximité d’'un point d’eau, de zones trés humides ou de condensation sauf si le produit a été
spécifiquement congu pour une application extérieure.

« Eloignez le produit des radiateurs et autres sources de chaleur.

» Débranchez toujours le produit de I'alimentation avant de le nettoyer et utilisez uniguement un chiffon sec non pelucheux.

INSTRUCCIONES DE SEGURIDAD

Las siguientes directrices de seguridad general se facilitan para ayudarle a garantizar su propia seguridad personal y
para proteger el producto frente a posibles dafios. No olvide consultar las instrucciones del usuario del producto para
obtener mas informacion.

* La electricidad estatica puede resultar nociva para los componentes electronicos. Descargue la electricidad estatica de
su cuerpo (p. €j., tocando algun metal sin revestimiento conectado a tierra) antes de tocar el producto.

* No intente realizar el mantenimiento del producto ni lo desmonte nunca. Para algunos productos con bateria
reemplazable por el usuario, lea y siga las instrucciones del manual de usuario.

* No derrame comida o liquidos sobre el producto y nunca deje que caigan objetos en las aberturas del mismo.

 No utilice este producto cerca del agua, en zonas con humedad o condensacion elevadas a menos que el producto esté
clasificado especificamente para aplicacion en exteriores.

* Mantenga el producto alejado de los radiadores y de otras fuentes de calor.

» Desenchufe siempre el producto de la alimentacion de red antes de limpiarlo y utilice solo un pafio seco sin pelusa

ISTRUZIONI PER LA SICUREZZA

Las siguientes directrices de seguridad general se facilitan para ayudarle a garantizar su propia seguridad personal y
para proteger el producto frente a posibles dafos. No olvide consultar las instrucciones del usuario del producto para
obtener mas informacién.

* La electricidad estatica puede resultar nociva para los componentes electronicos. Descargue la electricidad estatica de
su cuerpo (p. €j., tocando algun metal sin revestimiento conectado a tierra) antes de tocar el producto.

* No intente realizar el mantenimiento del producto ni lo desmonte nunca. Para algunos productos con bateria
reemplazable por el usuario, lea y siga las instrucciones del manual de usuario.

* No derrame comida o liquidos sobre el producto y nunca deje que caigan objetos en las aberturas del mismo.

* No utilice este producto cerca del agua, en zonas con humedad o condensacion elevadas a menos que el producto esté
clasificado especificamente para aplicacion en exteriores.

» Mantenga el producto alejado de los radiadores y de otras fuentes de calor.

» Desenchufe siempre el producto de la alimentacion de red antes de limpiarlo y utilice solo un pafio seco sin pelusa

VEILIGHEIDSINFORMATIE

De volgende algemene veiligheidsinformatie werd verstrekt om uw eigen persoonlijke veiligheid te waarborgen en uw
product te beschermen tegen mogelijke schade. Denk eraan om de gebruikersinstructies van het product te raadplegen
voor meer informatie.

» Statische elektriciteit kan schadelijk zijn voor elektronische componenten. Ontlaad de statische elektriciteit van uw
lichaam (d.w.z. het aanraken van geaard bloot metaal) voordat u

het product aanraakt.

* U mag nooit proberen het product te onderhouden en u mag het product nooit demonteren. Voor sommige producten
met door de gebruiker te vervangen batterij, dient u de instructies in de gebruikershandleiding te lezen en te volgen.

» Mors geen voedsel of vloeistof op uw product en u mag nooit voorwerpen in de openingen van uw product duwen.

» Gebruik dit product niet in de buurt van water, gebieden met hoge vochtigheid of condensatie, tenzij het product
specifiek geclassificeerd is voor gebruik buitenshuis.

* Houd het product uit de buurt van radiators en andere warmtebronnen.

U dient het product steeds los te koppelen van de stroom voordat u het reinigt en gebruik uitsluitend een droge pluisvrije
doek
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Disposing and recycling your product Q'.'

ENGLISH EN =@
This symbol on the product or packaging means that according to local
laws and regulations this product should be not be disposed of in the
household waste but sent for recycling. Please take it to a collection
point designated by your local authorities once it has reached the end
of its life, some will accept products for free. By recycling the product

e and its packaging in this manner you help to conserve the

environment and protect human health.

D-Link and the environment

At D-Link, we understand and are committed to reducing any impact our operations and
products may have on the environment. To minimise this impact D-Link designs and
builds its products to be as environmentally friendly as possible, by using recyclable, low
toxic materials in both products and packaging.

D-Link recommends that you always switch off or unplug your D-Link products when they
are not in use. By doing so you will help to save energy and reduce CO2 emissions.

To learn more about our environmentally responsible products and packaging please visit
www.dlinkgreen.com

DEUTSCH DE
Dieses Symbol auf dem Produkt oder der Verpackung weist darauf hin,
dass dieses Produkt gemal bestehender értlicher Gesetze und
Vorschriften nicht Uber den normalen Hausmiull entsorgt werden sollte,
sondern einer Wiederverwertung zuzufliihren ist. Bringen Sie es bitte
zu einer von Ihrer Kommunalbehérde entsprechend amtlich

I ausgewiesenen Sammelstelle, sobald das Produkt das Ende seiner

Nutzungsdauer erreicht hat. Flir die Annahme solcher Produkte
erheben einige dieser Stellen keine Gebilihren. Durch ein auf diese
Weise durchgefliihrtes Recycling des Produkts und seiner Verpackung
helfen Sie, die Umwelt zu schonen und die menschliche Gesundheit zu
schiitzen.

D-Link und die Umwek

D-Link ist sich den méglichen Auswirkungen seiner Geschéftstatigkeiten und seiner
Produkte auf die Umwelt bewusst und fihlt sich verpflichtet, diese entsprechend zu
mindern. Zu diesem Zweck entwickelt und stellt D-Link seine Produkte mit dem Ziel
gréBtmoglicher Umweltfreundlichkeit her und verwendet wiederverwertbare,
schadstoffarme Materialien bei Produktherstellung und Verpackung.

D-Link empfiehlt, Ihre Produkte von D-Link, wenn nicht in Gebrauch, immer auszuschalten
oder vom Netz zu nehmen. Auf diese Weise helfen Sie, Energie zu sparen und CO2-
Emissionen zu reduzieren.

Wenn Sie mehr (Uber unsere umweltgerechten Produkte und Verpackungen wissen
mdbchten, finden Sie entsprechende Informationen im Intermnet unter www.dlinkgreen.com.

FRANGCAIS FR

Ce symbole apposé sur le produit ou son emballage signifie que,
conformément aux lois et réglementations locales, ce produit ne doit
pas étre éliminé avec les déchets domestiques mais recyclé. Veuillez
le rapporter & un point de collecte prévu a cet effet par les autorités
locales; certains accepteront vos produits gratuitement. En recyclant

| le produit et son emballage de cette maniére, vous aidez a préserver
'environnement et & protéger la santé de I'homme.

D-Link et 'environnement

Chez D-Link, nous sommes conscients de |'impact de nos opérations et produits sur
l'environnement et nous engageons a le réduire. Pour limiter cet impact, D-Link congoit et
fabrique ses produits de maniére aussi écologique que possible, en utilisant des
matériaux recyclables et faiblement toxiques, tant dans ses produits que ses emballages.

D-Link recommande de toujours éteindre ou débrancher vos produits D-Link lorsque vous
ne les utilisez pas. Vous réaliserez ainsi des économies d'énergie et réduirez vos
émissions de CO2.

Pour en savoir plus sur les produits et emballages respectueux de |'environnement,
veuillez consulter le www.dlinkgreen.com

\
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ESPANOL ES
Este simbolo en el producto o el embalaje significa que, de acuerdo
con la legislacién y la normativa local, este producto no se debe
desechar en la basura doméstica sino que se debe reciclar. Llévelo a
un punto de recogida designado por las autoridades locales una vez
que ha llegado al fin de su vida util; algunos de ellos aceptan

] recogerdos de forma gratuita. Al reciclar el producto y su embalaje de

esta forma, contribuye a preservar el medio ambiente y a proteger la
salud de los seres humanos.

D-Link y el medio ambiente

En D-Link, comprendemos y estamos comprometidos con la reduccion del impacto que
puedan tener nuestras actividades y nuestros preductos en el medio ambiente. Para
reducir este impacto, D-Link disefia y fabrica sus productos para que sean o mas
ecolégicos posible, utilizando materiales reciclables y de baja toxicidad tanto en los
productos como en el embalaje.

D-Link recomienda apagar o desenchufar los productos D-Link cuando no se estén
utilizando. Al hacerlo, contribuird a ahorrar energia y a reducir las emisiones de CO2.

Para obtener mas informacion acerca de nuestros productos y embalajes ecoldgicos, visite
el sitio www.dlinkgreen.com

ITALIANO IT

La presenza di questo simbolo sul prodotto o sulla confezione del
prodotto indica che, in conformita alle leggi e alle normative locali,
questo prodotte non deve essere smaltito nei rifiuti domestici, ma
avviato al riciclo. Una volta terminato il ciclo di vita utile, portare il
prodotto presso un punto di raccolta indicato dalle autorita locali.

[ Alcuni questi punti di raccolta accettano gratuitamente i prodotti da
riciclare. Scegliendo di riciclare il prodotto e il relativo imballaggio, si
contribuird a preservare l'ambiente e a salvaguardare la salute umana.

D-Link e I'ambiente

D-Link cerca da sempre di ridurre I'impatto ambientale dei propri stabilimenti e dei propri
prodotti. Allo scopo di ridurre al minimo tale impatto, D-Link progetta e realizza i propri
prodotti in modo che rispettino il pit possibile I'ambiente, utilizzando materiali riciclabili a
hasso tasso di tossicita sia peri prodotti che per gli imballaggi.

D-Link raccomanda di spegnere sempre i prodotti D-Link o di scollegarme la spina quando
non vengono utilizzati. In questo modo si contribuira a risparmiare energia e a ridurre le
emissioni di anidride carbonica.

Per ulterion informazioni sui prodotti e sugli imballaggi D-Link a ridotto impatto
ambientale, visitate il sito all'indirizzo www.dlinkgreen.com

NEDERLANDS NL
Dit symbeool op het product of de verpakking betekent dat dit product
volgens de plaatselijke wetgeving niet mag worden weggegooid met
het huishoudelijk afval, maar voor recyclage moeten worden
ingeleverd. Zodra het product het einde van de levensduur heeft
bereikt, dient u het naar een inzamelpunt te brengen dat hiertoe werd

[— aangeduid door uw plaatselijke autoriteiten, sommige autoriteiten

accepteren producten zonder dat u hiervoor dient te betalen.
Door het product en de verpakking op deze manier te recyclen helpt u
het milieu en de gezondheid van de mens te beschermen.

D-Link en het milieu

Bij D-Link spannen we ons in om de impact van onze handelingen en producten op het
milieu te beperken. Om deze impact te beperken, ontwempt en bouwt D-Link zijn
producten zo milieuvriendelijk mogelijk, door het gebruik van recycleerbare producten met
lage toxiciteit in product en verpakking.

D-Link raadt aan om steeds uw D-Link producten uit te schakelen of uit de stekker te
halen wanneer u ze niet gebruikt. Door dit te doen bespaart u energie en beperkt u de
CO2-emissies.

Breng een bezoek aan www.dlinkgreen.com voor meer informatie over onze
milieuverantwoorde producten en verpakkingen

vi
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POLSKI PL
Ten symbol umieszczony na produkcie lub opakowaniu oznacza, ze
zgodnie z miejscowym prawem i lokalnymi przepisami niniejszego
produktu nie wolno wyrzucac jak odpady czy smieci z gospodarstwa
domowego, lecz nalezy go poddad procesowi recyklingu. Po
zakonczeniu uzytkowania produktu, niektére odpowiednie do tego celu

[ ] podmioty przyjma takie produkty nieodplatnie, dlatego prosimy

dostarczyé go do punktu zbidrki wskazanego przez lokalne wiadze.
Poprzez proces recyklingu i dzieki takiemu postepowaniu z produktem
oraz jego opakowaniem, pomogg Panstwo chroni¢ srodowisko
naturalne i dba¢ o ludzkie zdrowie.

D-Link i sSrodowisko

W D-Link podchodzimy w sposob swiadomy do ochrony otoczenia oraz jestesmy
zaangazowani w zmniejszanie wplywu naszych dziatan i produktdw na srodowisko
naturalne. W celu zminimalizowania takiego wptywu firma D-Link konstruuje i wytwarza
swoje produkty w taki sposéb, aby byly one jak najbardziej przyjazne srodowisku, stosujac
do tych celéw materiaty nadajgce sie do powtdémego wykorzystania, charakteryzujgce sie
matg toksycznoscig zarbwno w przypadku samych produktéw jak i opakowar.

Firma D-Link zaleca, aby Panistwo zawsze prawidiowo wylgczali z uzytku swoje produkty D-
Link, gdy nie sg one wykorzystywane. Postepujac w ten sposéb pozwalajg Panstwo
oszczedzad energie | zmniejszal emisje COZ.

Aby dowiedziel sie wiecej na temat produktdéw i opakowar majacych wplyw na srodowisko
prosimy zapoznac sie ze strong internetowg www.dlinkgreen.com.

CESKY cz
Tento symbol na vyrobku nebo jeho obalu znamena, ze podle mistné
platnych pfedpisd se vyrobek nesmi vyhazovat do kemunéiniho
odpadu, ale odeslat k recyklaci. Az vyrobek doslouzi, odneste jej
prosim na sbérné misto urfené mistnimi Urfady k tomuto Ucelu. Néktera
sbé&rnd mista pfijimaji vyrobky zdarma. Recyklaci vyrobku i obalu
] pomahate chranit zivotni prostiedi i lidské zdravi.

D-Link a Zivotni prostiedi

Ve spolegnosti D-Link jsme si v&domi vlivu nadich provozd a vyrobk{ na Zivetni prostfedi a
snaZime se o minimalizaci t&chto vlivd. Proto své vyrobky navrhujeme a vyrdbime tak, aby
byly co nejekologitté&jsi, a ve vyrobcich i obalech pouzivame recyklovatelné a nizkotoxické
materialy.

Spoletnost D-Link doporutuje, abyste své vyrobky znatky D-Link vypnuli nebo vytahli ze
zasuvky vzdy, kdy? je nepouzivate. PomiZete tak Setfit energii a sniZit emise CO2.

Vice informaci o nasich ekologickych vyrobcich a obalech najdete na adrese
www.dlinkgreen.com.

MAGYAR HU
Ez a szimbdlum a terméken vagy a csomagoldson azt jelenti, hogy a
helyi térvényeknek és szabélyoknak megfelelden ez a termék nem
semmisitheté meg a haztartasi hulladékkal egyltt, hanem
Ujrahasznositasra kell kildeni. Kérjlk, hogy a termék élettartamanak
elteltét kévetden vigye azt a helyi hatosag altal kijeldlt gyljtShelyre.

] A termékek egyes helyeken ingyen elhelyezheték. A termék és a

csomagolds Ujrahasznositasaval segiti védeni a kérnyezetet és az
emberek egészségét.

A D-Link és a kérnyezet

A D-Linknél megértjik és elkételezettek vagyunk a mlveleteink és termékeink kémyezetre
gyakorolt hatdsainak csékkentésére. Az ezen hatds csokkentése érdekében a D-Link a
lehetd leginkabb kérnyezetbarat termékeket tervez és gyart azaltal, hogy
Ujrahasznosithato, alacsony kérosanyag-tartalmu termékeket gyart és csomagolasokat

A D-Link azt javasolja, hogy mindig kapcsolja ki vagy hizza ki a D-Link termékeket a
tapforrdsbdél, ha nem haszndlja azokat. Ezzel segit az energia megtakaritdsaban és a
széndioxid kibocsatasanak cstkkentésében.

Kérnyezetbardt termékeinkrél és csomagolasainkrol tovabbi informacidkat a
www.dlinkgreen.com weboldalon tudhat meg.

Vii
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NORSK NO
Dette symbolet pa produktet eller forpakningen betyr at dette
produktet ifelge lokale lover og forskrifter ikke skal kastes sammen
med husholdningsavfall, men leveres inn til gjenvinning.
Vennligst ta det til et innsamlingssted anvist av lokale myndigheter
nar det er kommet til slutten av levetiden. Noen steder aksepteres

[ ] pradukter uten avgift. Ved pd denne méten & gjenvinne produktet og

forpakningen hjelper du & verne miljget og beskytte folks helse.

D-Link og miljeet

Hos D-Link forstar vi oss pa og er forpliktet til 8 minske innvirkningen som var drift og
vare produkter kan ha p& miljeet. For & minimalisere denne innvirkningen designer og
lager D-Link produkter sem er s& miljgvennlig secm mulig, ved & bruke resirkulerbare, lav-
toksiske materialer bdde i produktene og forpakningen.

D-Link anbefaler at du alltid sl&r av eller frakobler D-Link-produkter nér de ikke er i bruk.
Ved 8 gjere dette hjelper du & spare energi og & redusere CO2-utslipp.

For mer informasjon angdende vére miljeansvarlige produkter og forpakninger kan du g8 til
www.dlinkgreen.com

DANSK DK
Dette symbol p8 produktet eller emballagen betyder, at dette produkt
i henhold til lokale love og regler ikke m& bortskaffes som
husholdningsaffald, mens skal sendes til genbrug. Indlever
produktet til et indsamlingssted som angivet af de lokale
myndigheder, nér det er ndet til slutningen af dets levetid. I nogle

| ] tilfeelde vil produktet blive modtaget gratis. Ved at indlevere

produktet og dets emballage til genbrug pd denne made bidrager du
til at beskytte miljeet og den menneskelige sundhed.

D-Link og miljeet

Hos D-Link forst8r vi og bestreeber os pé at reducere enhver indvirkning, som vores
aktiviteter og produkter kan have pd miljeet. For at minimere denne indvirkning designer
og producerer D-Link sine produkter, s& de er s& miljgvenlige som muligt, ved at bruge
genanvendelige materialer med lavt giftighedsniveau i bdde produkter og emballage.

D-Link anbefaler, at du altid slukker eller frakobler dine D-Link-produkter, nér de ikke eri
brug. Ved at gere det bidrager du til at spare energi og reducere CO2-udledningerne.

Du kan finde flere oplysninger om vores miljgemasssigt ansvarlige predukter og emballage
pd www.dlinkgreen.com

SUOMI FI
Téamé symboli tuotteen pakkauksessa tarkoittaa, ettd paikallisten
lakien ja sdannosten mukaisesti tata tuctetta ei pida havittaa yleisen
kotitalousjatteen seassa vaan se tulee toimittaa kierrdtettavéaksi. Kun
tuote on elinkaarensa paasséd, toimita se l[dhimpé&én viranomaisten
hyvaksymaan kierratyspisteeseen. Kierrattamalla kaytetyn tuotteen ja
] sen pakkauksen autat tukemaan sekd ympéristén ettd ihmisten

terveyttd ja hyvinvointia.

D-Link ja ymparisto

D-Link ymmartda ymparisténsuojelun térkeyden ja on sitoutunut vahentdmaan
tuotteistaan ja niiden valmistuksesta ympéristélle mahdollisesti aiheutuvia
haittavaikutuksia. Nama negatiiviset vaikutukset minimoidakseen D-Link suunnittelee ja
valmistaa tuotteensa mahdollisimman ympéaristoystavallisiksi kéyttamalla kierrétettavia,
alhaisia pitoisuuksia haitallisia aineita sisaltédvia materiaaleja seké tuotteissaan etta
niiden pakkauksissa.

Suosittelemme, ettd irrotat D-Link-tuotteesi virtalahteestd tai sammutat ne aina, kun ne
eivat ole kaytdssa. Toimimalla ndin autat sddstdmééan energiaa ja vahentamaan
hiilidioksiidipaastoja.

Lue lisaa ympéristoystavallisistd D-Link-tuotteista ja pakkauksistamme osocitteesta www.
dlinkgreen.com
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SVENSKA SE
Den har symbolen p& produkten eller forpackningen betyder att
produkten enligt lokala lagar och féreskrifter inte skall kastas i
hushallssoporma utan i stallet 3tervinnas. Ta den vid slutet av dess
livslangd till en av din lokala myndighet utsedd uppsamlingsplats,
vissa accepterar produkter utan kostnad. Genom att p& detta satt

[ ] dtervinna produkten och férpackningen hjalper du till att bevara miljén

och skydda manniskors halsa.

D-Link och miljon

P& D-Link forstr vi och &r fast beslutna att minska den pdverkan vara verksamheter och
produkter kan ha pd miljén. For att minska denna p&verkan utformar och bygger D-Link
sina produkter for att de ska vara s miljévanliga som méjligt, genom att anvanda
dtervinningsbara material med 18g gifthalt i bdde produkter och férpackningar.

D-Link rekommenderar att du alltid stanger av eller kopplar ur dina D-Link produkter nér
du inte anvander dem. Genom att gdra detta hjalper du till att spara energi och minska
utslapp av koldioxid.

Foér mer information om vara miljdansvariga produkter och férpackningar
www.dlinkgreen.com

PORTUGUES PT
Este simbolo no produto ou embalagem significa que, de acordo com
as leis e regulamentacdes locais, este produto ndo devera ser
eliminado juntamente com o lixo doméstico mas enviado para a
reciclagem. Transporte-o para um ponto de recolha designado pelas
suas autoridades locais quando este tiver atingido o fim da sua vida

[ I— (til, alguns destes pontos aceitam produtos gratuitamente. Ao reciclar

o produto e respectiva embalagem desta forma, ajuda a preservar o
ambiente e protege a saude humana.

A D-Link e o ambiente

Na D-Link compreendemos e comprometemo-nos com a redugdo do impacto que as nossas
operagdes e produtos possam ter no ambiente. Para minimizar este impacto a D-Link
concebe e constréi os seus produtos para que estes sejam o mais inofensivos para o
ambiente possivel, utilizando meteriais reciclaveis e ndo tdxicos tanto nos produtos como
nas embalagens.

A D-Link recomenda que desligue os seus produtos D-Link quando estes ndo se
encontrarem em utilizagdo. Com esta acgdo ajudard a poupar energia e reduzir as
emiss8es de CO2.

Para saber mais sobre os nossos produtos e embalagens responsaveis a nivel ambiental
visite www.dlinkgreen.com

April, 2020




DGS-1100 Series Switch Web Ul Reference Guide

Table of Contents
1.

Table of Contents

X
Introduction
AUGIENCE. ...t ettt ettt et et e e e te et e e tt e teeteeeteeabeeaeeabesbeesseetsesbeetsesseeaseabeeas e seeaseeesessesaeentestsenteersenteenseteeasenteenns 1
Other DOCUMENTATION......c.ociiiiiitieiiitiet ettt ettt ettt teete et e et e et e e b e b e s s essessessessessessessesseseessebeeseese b e ssessesbessessessessesseseesess 1
CONVENTIONS. ...ttt ettt et e e e et e teessesseestesseessesseessesssesseesse s eess et e ess e s e esseeseesseaseenseaseeseessessaessensaessenseensenseensenss 1
NOtES, NOLICES, AN CAULIONS. .......ocuiiiiieeeii ettt ettt et eete et este e e e s teesbesteeabeetsesseessenseesseeseesseaseessesseessesreansens 2
Product Introduction 3
DIGS-TTA00-TOV2.......oceeeeeeeeeeeeeeeee ettt et ete et e et e et e e te et et et e s easeeseseeaeeseesseseeteeseeteeteeteeseeseas et ese s enseneeneereereereereereere e 3
FTONE PANEL......oiiieie ettt ettt ettt et e et e teebe e b e be b esses b esb e st esbesseseeseeseessesees e beeb e b esbesbessessensensessesseneens 3
REAEI PANEL......ooieeieeeeeee ettt et ettt et e et e et e e te et e e te e beetb e be e et e eteeabeeaeeabeeteeateeat e teettebeett e beetseeteenteeteenteareennas 4
DGS-TT00-24V2........eeeeeeeeeeeeeee ettt et et e et e et e et et et e s ems e et et eaeeaeeaeete et e eteeteete et e et e et e et et et et et et et eneereereereereere e 5
FRONT PANEL....ooiiceeeeeeeeee ettt ettt st e b e bt e b e et e e s b e e st e s s e ess e seesseeseessesaeessesaeensesssesseessenseessansaessenseensanseensenseensas 5
REAI PANEL.......oeioeeieeeee ettt ettt ettt et e et e et e e te et e ett e beeab e be e et e eteeabeeaeeateeteeateeat e teettebeett e beetteebeenteeteeateareennas 5
DIGS-TA00-24PV 2.ttt ettt ettt ettt ettt et e e b e e b e b e s b esb e st essesb e st e st et s eseese et e ebeebees e b e b esseab e s b esbenbetseseeneeteeaeeneereebenes 6
FRONE PANEL.....c.oieeeeee ettt ettt et ettt et e e bt et e ete e beets e beeaseeteeaseeaeeateeaeentesesesseessenseessenbeesseteensesseenseereennas 6
REAI PANEL.......ooiiiiieeee ettt ettt ettt te et ettt e et e b e b e b et e b e s b e st e st et s ess st ete e ke eteeheeh e b e b e b e s b e s b estesbessentereeteene e 7
DGS-TT00-TOMPYV2......ooioioeietieteeteet ettt ettt ettt ettt ettt teete et e et e b e s e s esbessessessesseseestessessessese et s esees e b e se s essessessessessessessessesseseeseeseesens 7
FRONT PANEL.....oeieeieeeeeee ettt ettt ettt et e et e et e e ts e beets e beeaseeteeaseeaeeaseeesenbesesesseesbenteessenbeesseseensasseensesreeneas 7
REAEI PANEL......ciioeeeeeeceee ettt ettt st et e s e e st e st e e b e et e es s e et s esseess e s e ass e st aseeeheeRseeReenseeReea b e esaenb e e st e teesseseenseeteenteereennas 8
DGS-TT00-TOMPPV 2. ettt ettt e et e et et e et et e s et et eseeseeseeteeteetesteeteeteese et esessentensenserseseeseereereereesens 8
FTONE PANEL. ...ttt ettt ettt ettt ekt eteebeeb e e b e b e b ess e s b essessessesseseeseeseesseseeseebees e besbesbessessensensessessene e 8
REAEI PANEL......ooieeieeeeee ettt ettt ettt et e bt et e ettt e e te e beetb e be e et e eteeabeebeeabesaeeateeaeeteeab et e etb e beetbeeteenteeteenteareennas 9
DGS-TA00-26IMPYV 2.ttt et et e et e et et e et et et e s e e et eseeseesseseeteeseeteeteeteeteesees et ese s ensensenseneeseereereereere e 9
FTONE PANEL. ...ttt ettt at ettt e te et e ete et e ebees e b e b e s e ssesbessesbessessessessetseaeeseebeeaeebe s e b e be st essenne 10
REAI PANEL......ooieeieeeeee ettt ettt ettt et et e te et e et e e te et e ete e teeae e beere e beetb e teeabeateeabeeteeabeeaeeateeaeeteereereeneas 10
DGS-TT00-26IMPPV2.........ooieieetieeeeeteeteete ettt ettt ettt ettt ettt e et e e b e es e b e b essessessessess et s essess et e eseeseese b e be s essessesbessessessesseseesseneesess 11
FPONE PANEL....ooiiceiee ettt ettt et e sttt e st e e st e s beesb e s st esseesaesbeessesseeseesseeseesseeseeseensesseessesseessensaensenseensenseensenns 11
REAI PANEL......o.oo ittt ettt et et ettt e b et e et e e te et e ere e teeat e beere e beetb e beeabeeteeabeebeeabeeaeeabeeaeeteereereeneas 12
DIGS-TA00-TBPV2......o oottt ettt ettt ettt ekttt et e et e eb e e b e b e b essessessestess et s esseseeseeseeaeese b e be s essessesbessessessesseseeseeneerers 12
FRONT PANEL....ooeieeeeeee ettt ettt ettt et et e s te et e e teesbeete e st e eteeabeesseabeeasesbeeaseeseeasesaeessesssessesssensesssenteessenrens 12
REAI PANEL.......coiiiiieeeeee ettt ettt ettt te et e et e e b e e b et ab e s s e st st et b e st ere et e eteehe et e b e b e b e b e b e st esbessentessetseteereereeae e 13
Hardware Installation 14
SEEPT: UNPACKING ...ttt ettt etttk et bt b et b et b e st bt e s e st e e e b es e e b et eb et e b et eb et e bt st bt st e bt st st atenea 14
Packing contents of DGS-1100-16V2 /24V2 /24PV2/10MPV2/10MPPV2/26MPV2/26MPPV2/18PV2............ccocuo...... 14
SteP2: SWILCH INSTAIIATION. .......c.ooeeeeeeee ettt ettt te et e e teeteete et e et e et et et et enseseeasenseseereeneas 14
Desktop Or Shelf INSTAIAtION............cooiiiiie ettt ettt ettt e te bt e s b e b e b essessessessessessessesseneeseeseans 14
RACK INSTAIIALION. ..ottt et ettt e et et e e tt e e teeta e beeabeebeeabeeseesseeseesbeeseenseereeseesseseessesseesnen 15
Step 3 — Plugging in the AC POWET COId.........c.coiiiiiiieiieieeccteteete ettt ettt ettt et teete et ebeebesb e b e b e s essessessessessesseneeseas 16
POWET FAIUIE......c.oieiee ettt ettt ettt et e s st et e e st e b e esses b e es b e beesseeseenseeseesseeseensesnsessesseessesssenseessasseassansanns 16
Grounding the SWITCN ..ot ettt bbbt b et b e bttt ne 16
Web-based Switch Configuration 18
Y T aE= Te =T a0 L=t Y A @] o] i o] F= 3OO 18
Connecting using the WEeb USEr INTEITACE...........c..oviiiiiieiccce ettt ettt ettt et se s eteeteebeereens 18
Logging ONtO the WED IMaNAGET..........ouiiieieeeeeeee ettt ettt ettt te et e s teeae s te et e e te et e essenbeesseebeeaseeseeasesreeneeeeis 19




DGS-1100 Series Switch Web Ul Reference Guide

SIMNAM WIZAIA. ...ttt e e et e et e et e e ae e eaa e e eas e e et e ett e st e e ettesateesaseeaaeesaseeaseesaseeaseesssesaseessseenreens
WeED USET INtEITACE (WED UL ....ooiiiiiiiieeee ettt ettt ettt et ettt st st eteeteeteebeebeebesbe s e b e b essesbessestessesaessereeseanens
ATEAS OF Tt USEI INEBITACE. ... ..o ettt e e e st e et e e e e e e st eeeseaeeesenaeeeseaaeesaranesns

System

DEVICE INTOIMATION......c.iitiietiiciicte ettt ettt ettt b ettt s e b e st s e st e s e st ese st et essese s et e seseeseseesassesassesensesesseseasesesesesesesenes
System INfOrMatioN SEHINGS.........c.ooviiiie ettt ettt et sbesa e st e ssesseseeseetseaeeseebesbessesessessens
SYSIEM INFOMMIALION.......c.ooeeeeee ettt ettt ettt et et eaeeteeteeteeteeteese s et esensensensessereenserea
1 [ g1 (=Y =T TSR U OO
IPVB INTEITACE. ... eeeeeeeeieteee ettt ettt ettt s st b e st b e st s en et ea e e s ea et en s et e et es e s e st b es e s eneesenteseneesensesensenensenn
Lo T OTeT o} iTe U =11 o OO SOTROOO
Port Settings(DGS-1100-16V2/24V2/24PV2/10MPV2/10MPPV2 ONlY)....c.ooviiiiiiiieicieeeieeeeeeeeeteeeeee e
Port Settings(DGS-1100-26MPV2/26MPPV2/18PV2 ONIY).....ooviuiiieiiieieieieteieeieeetesteit ettt sse s
Port Status(DGS-1100-16V2/24V2/24PV2/10MPV2/10MPPV2 ONIY)......coooviiiieiiieiitiecieeeeteeeeee et
Port Status(DGS-1100-26MPV2/26MPPV2/18PV2 ONIY)....ciiiiiiiieiiieiiieiiietesieitetetteie ettt ssens
N1 g1 o To TN =10 1 = TSROSO
POE (POE MOAEI ONIY)....oviiiiiitieiieieiectet ettt ettt ettt ettt b bbb sbesb e st essesaeseeseeteeseeseesaebeeseesessessessessessessessessesseseesesas
POE SYSEIM ...ttt ettt e et ea et ettt e teeaeete et e et e et et et et et et ettt eaeeaeeteeteeteeteeeenns
POE SEATUS......eoeieeteeee ettt ettt ettt ettt s et s et etk et b e et et R et a e ARt b e Rt e ke Rt et ent ke nteben e ebe e ebe s ene s eneeene
PoE Configuration(DGS-1100-24PV2/10MPV2/26MPV2/18PV2 ONIY)......cccvriiiiieiiieieieieteeteteeee et
PoE Configuration(DGS-1100-10MPPV2/26MPPV2 ONIY).......coooieiieiiieiieeeietetet ettt ss e enens
PD ALIVE. ...ttt h b bttt bttt st h e st e h e b e e bt bt ekt e bt h e e h ke b b ettt e st e st eateateh e e bt bt bbb e
Y] =1 ¢ 1 e o OO OU
SYSIEM LOG SELNGS ..ottt ettt ettt et et e sb e st e st etseseeseeteeseeseeb e b e b e s essessestessessesseseesseseeneeseesenns
SYSIEM LOG SEIVEE SEHINGS. ... oottt ettt ettt et eteeteeteeteeteeteeteeae et e s ensene e e eaeens

ClOCK SEHINGS. ...ttt bbbt b et bbbt s bbbt b et bt eh bbb e s et e st n bt n et ebenes
THIME ZONE SEIINGS. ..ottt ettt ettt et et sb e st e sb e st eseeseetsesseseeseebees e s esbessessessesbessessessesseseeseeseesessessessans
T NI RS 7= 1] g o [OOSR
THME RANGE. ...ttt ettt ettt ettt et e et e e bees e b e b e s esbesb e st essessessessessessesseseebeebeese b e b e b essessessessessessereeseeteene e

Management

SNIMP GIODAI SEINGS......eeoeeeieeeeeee ettt ettt et e et e e s e eaeeaeeaeeteeteeteeteeteeseseesesensensensenseseereereas
SNMP Community Table SELHNGS.......cooiiieieicicceee ettt ettt ettt sb b b et essess st eseetaeaeeteeseebeeseesebeses
SNMP HOSE TAbIE SEENGS. ...ttt ettt et et et e s et eseeseeaeeteeseeteereeteeneans
HTTPIHTTPS ..ttt etttk ettt e st b e st b e s e s e s e s et e st s e st s e st b e st e b e st e b en e e b en s e s enses e s es e s e st bene et eneebeneebeneeseneens
D-LiNK DISCOVEIY PIOTOCOL........oiiieiiiiieiectteee ettt ettt ettt e st e sbeestesbeessesseessesseensesssesseessesseessenseessesseesseseeneesseaneas

L2 Features

MAC AdAress Table SEHINGS.........ociiiiiiiieeeec ettt ettt ettt et e b e b et e b essess e st essessessetsesseseetessesbesessenes
MAC AAAIESS TaDIE......c.eiceiieeeeeeee ettt ettt ettt et e et e et e et e ete et e sbeessestsesteessenbeetsenseessenseessesseessesseensesreensesreas

VLAN Configuration WIZAId...........c.covoiiiiiiieieiieeet ettt ettt ettt eteeteeteeteeteebeesesbesbesbessessessessessessesserseseeseeseesensas
BOZ2.TQ VLAN . ...ttt ettt ettt et ettt et et et et et e s et e s s ese s b et e ebeseeb e st e s eseebestebessebe st e s et ese s et e s ese b eseebeneebeseebe st ebene et eneesennens
MaNAGEMENT VLAN ...ttt ettt ettt e st est et s eseeseeteeteeseese et e ebe e b e b e b e s e st esbessessessessensessessenseseereabessesessesee

Xi



DGS-1100 Series Switch Web Ul Reference Guide

ASYMMETTIC VLAN. ..ottt ettt ettt et et e st ess e st e st ese et s eseete et e ese b e b esbessessessessessessessesseseeaeeseesabesessessenne 52
WLAN INEEITACE. ....ce ittt ettt ettt ettt ettt et et et e b et et et e s e e e st s e e st eb e st e b e st et e st et entebentebeneebe st ese s esensenesens 53

AULO SUINVEIIIANECE VLAN. ... oottt ettt ettt e st e st e st ese et e eseesees e s e as e s ensensensensensensaneeseeneeseeseasesseesensan 56

VOICE VLAN. ...ttt ettt ettt ettt e st e ket et e e e b et e b e s e st s e e st e b e st e b e st e ben e e b eneeben e e b en e e b et eb e s ese st eseeseneebeneebeneebeneee 58
SPANNING TIEE.....eeeeeeeeeeeeeee ettt ettt et e te et e e te et et et e s et e s eseeaeeseesseseeseeseeteeseeteeseese et et et ensenseneeneeneeaeereeneereere e 61
STP GlODAI SEEINGS. ....cvioiiiiiiiictietectet ettt ettt et et sb st st etsesseteeteesseseese b e bessessessessessessessessessessenseseeseesessens 62

STP POt SEENGS. ...ceeceeeeeeeeeeeeeeeeee ettt ettt et et et e ese et eae et e eaeeteeteeteeteeteese et esensersensenseseenseseeseerearea 62
LOOPDACK DELECHON. ...ttt ettt et b et b et b e bt b bbbt et e st b e st sb et bt b et enn 63
(o] Qe o =Y £- i o o PSPPSRI 65

L2 MUIICAST CONIOL.......vieiiiieiciieietiietete ettt ettt ettt ettt et s et e s et e s ese e s et e eseseesasseses s et ess et easesess et e s esa s eseeseseesessesensesensesensess 67
IGIMP SNOOPING......eiuiiiieiieiieiteteeteee ettt ettt ettt st ete st et e eteebees e b esbe s essess e st ess et s essesteseeseeaeeseeseese s essessessessessessensessessensereas 67
MURICAST FIEIING ...ttt et et e et e et e et e et e e aeeateeaseaeeaseabeessesteesseabeesbeessenteessenseesseseenns 70

LLDIP ettt ettt etttk etk et ekt s e Rt b e Rt A en e s e a skt ek ea skt e st se st b e st ehen e s e Rt s en e ke n s et en s et en b en b en e beneabeneesenes 71
LLDP GIOD@I SEENGS....c.eiuieiiiiieiieiieieeiteteteete ettt ettt ettt ettt ettt et e e teebeeb e b e be s essessessessessessessessessessesseseabeesebesbessessessenns 71

LLDP Neighbor Port INfOrM@tIoN. ........c..coiii ettt bbbttt 71

8. Quality of Service (QoS) 72
LSO 2 o TN o o] 1 2SSOSR 72

POIt RALE LIMITING......cvieeeiieeiece ettt ettt etttk et e be st e b e seese st es e e b e st et e st ebeneebeneebeneebeneebeneesennns 73

9. Security 74
Safeguard ENGINE SEHINGS. ......coo ittt ettt ettt ettt bt eb et e bt st bt sbe st st st st e st ettt e e ebe e ebe e 74
Traffic SEGMENTALION.......c.ociitiitii ettt ettt et se ettt e teeteete et e ebeeb e b e b essessessessessessessessesseseeseesesessessessessans 74
STOMM CONIIOL.......octiieticiece ettt ettt ettt te b ete s b ese e b eseebes e e b eseesaseebessebessese s e s e ssese s eseeseseebeseeseseesensesensesensesensesessns 75
DOS Attack Prevention SEHINGS.........cooioiiiiieeeeeee ettt ettt re ettt te et et eeteebeebe b e b e s esbessessessasserseaseseeseesens 76
ZONE DEFENSE SEIINGS. ... .ottt ettt e e e te et e eaeete et e et e e s e s e s e e eseseeseeseeseeseereereeseeaeeeenes 77
SO ettt ettt ettt h ettt e Rtk e stk e stk e a e ekt ek et R et eE et Rt et e st eh e Rt R e Rt ek en ek en e ek et ek et et et et e et et e eteseebeneebeneeteneas 77
SSL GIODAI SEHINGS.....ocuiiviiiiiiiitieeect ettt ettt ettt ettt e st eseeteetseteeseeteebees e b esbe b esbessessessessessesseseeseeseeseesessebens 77

10. OAM 79
CaDIE DIAGNOSTICS. .....viviviieiet ettt ettt ettt ettt e st e st e st estets et e eseeteeteeseesees e b e s e s e s b e s s essesses s entets et s eneeaeeteebeeaeebe b ebe b ensenee 79
11. Monitoring 81
SHAEISTICS. ..ttt ettt ettt ettt e et s bRt b e Rt b e st sen e b en e Ren e R e bRt b e st be st b e st b e st et e st ese s ene et eneesens 81
PO COUNTETS.... .ottt ettt sttt e b et e s e st e st es e estesees e eseeseeseee et e se s ansensensensensenseneeneeseeneeseeseasessessesenes 81
IVIETOT SEHINGS. ...ttt et h bbbt b et b et bt bbbt bbb e st b et e b et e b et eb et b na st et s ne 82
12. Green 83
POWET SAVING......o ettt et ettt e et e et et et et et e e st eseesees s esseseeteeteeteeteeteese et st et et ensessensensesseseesseaeereereerea 83
BB E ettt a et s bRt b Rt b e Rt h e R b en s e a s e R et e Rt s R et e Rt b e Rt ke Rt be st e b et s et s et se b eneebeneee 85
13. Save and Tools 86
SAVE CONFIGUIALION.......cuiiiiiiiiiieticictieeeectet ettt ettt ettt et et et b e s b e st esbesbese e st essessese et e ebeeseebessessessessessessessessensesseseesessessassessens 86
FIrMWare INFOMMIETION.........c.oiiiie ettt ettt ettt s e et e st e st s e e st et e st et ene et en e et e st ebe st ebeneebe e esenseseneens 86
Firmware UpGrade & BaCKUP........c..coi ittt bbbttt b ettt aenes 86
Firmware Upgrade frOmM TETP........c.ooie ettt ettt et ettt e et b e b e b e s e sb e s esbessesseseesseseeseens 87
Firmware Upgrade fTOM HTTP..... ..ottt ettt e et e et et et e s e e e e e eseeaeeteeseeteereeteeneans 87
Firmware BACKUP 10 HT TP .. ..ottt ettt ettt stesbesa st essetseteese et e ese s esesbe s essessessessessessenseneas 87
FIirmware BaCKUD 10 TFTP. ... ettt ettt ettt et e b e et e beeabeebeeateereeateeaeensesteesbeessenseessesteessenreens 88
Configuration RESIOrE & BaCKUP. ........coiuiiiiiiiee ettt b ettt b sttt sttt et e b et neeben 89
Configuration RESOre fromM HT TP .......cooiiiiiieteeee ettt ettt ettt v bbb sb s b e s st essesseseeseetaeaeeteeseebeeseesesesns 89
Configuration RESIOre froOM TETP.........oc.oioeieceeeeeeeeeeee ettt ettt e teeteeteete et e ete et et e s e s e e et enee e eneereenes 89

Xii



DGS-1100 Series Switch Web Ul Reference Guide

Configuration BacCKUP 10 HT TP ........iiiiiiieeeeete ettt ettt ettt ettt eteeteebeebeebe st e b esb e s essessessessesseseeseans 90
Configuration BACKUP £10 TFTP.........ccioiiiiiiiieceeteet ettt ettt ettt ettt ettt et esseseetsesseseeseeteebeebassessessessessessessessassesseseas 90

LOG BACKUP. ...ttt bbbt b et b et b e bt b bt ekt b et h et h et bt bt b et b ettt bt ne 90
LOG BACKUD 10 HT TP ...ttt ettt ettt et et s b st et s e st eseete et s esees e e b e ebe b e b esbessessessessessessessenseseeseeseesens 90

LOG BACKUP 10 TETP ...ttt ettt ettt et et e te e st e be e s s e beeaseeteeaseeteenseeseenseesseteessesseessessessentsensenseans 91

PN ettt h et e bbb e st st ea b e st sttt ekttt ket e ke eb e b e b e b e b ea b e st e st ess et b eneetteseeseereeteeseeaeeseebeebessesensersens 92
RS ...ttt ettt ettt et ettt et et et ea e e st eateateR e eA e eRe Rt e Rt eRe Rt ket e se s ententententententeneenteseeseeteeteeneeseeseasensens 92
REDOOT SYSTEM.....coe ettt ettt ettt e ettt e e be e et e s e e en e e st ee e e st es e eseeseea e et e esesse s e sensensensenseneeneeneaneeneeseesees 93
14. Appendix A - Ethernet Technology 94
Gigabit EtNernet TECRNOIOQY........c.o oottt te et e e teeteete et e et e et et e s esenseneeneensereeseereas 94
Fast EtNErNEt TECNNOIOGY.......cooiiiiiiieiieice ettt ettt ettt ettt bessesbess e st eteetseaeeseeseebesse s esbessessessessessensessassereas 94
ANV} (od aTTaTo I K=Yl o aTo] [oTe V20O 95
15. Appendix B - Technical Specifications 96
Hardware SPECITICALIONS. .........c.ociiiiiiiiici ettt ettt ettt et eteeteeteeteebeebeeb e b e b essessessessessesseseesseseeseeseesessessessessassans 96
Key Components / PEIfOIMENCE.......c.oouciiiiiii ettt bbbttt st ne 96

POIE FUNCHIONS. ...ttt sttt sttt ettt ettt et et et e st et et et et et et e b e seese b e st e b es e e b e st ebentebeneeb et ebeneebeneesennns 96
PhySICal & ENVIFONIMENT........oouiieieiieeeeeeeeeeee ettt ettt ettt et et e ettt et eseeseeaeeaeeteeseeteeseete et e ese s e s et ensenseneereens 96
EMISSION (EMI) CertifiCAtiONS.........ocviiiiiiiiiiieeeee ettt ettt ettt et b bbb sbesbessessessesseseeteerseseesesbessesessenns 96
SaAfEty COItIfICAtIONS. ........eieieeeeeeeeee ettt et et e et e et e et e et et et et e e e e ere e e eaeeseeaeeteeseeteereeteeneans 96
FRATUIES....c.eee ettt ettt ettt et et et et e st eat et e e st e st et e e s e es e s e se s e s easensensensenteR e eR e eR e eReeRe R e Reehe s e te s et ensententeneeneeneeneas 96

L2 FRATUIES.....eeeeeee ettt b ettt ettt e h e bt e bt e bt e bt b e e bt bbb et en b st en e bt e bt e bt bt e bt bbbt et tenee 96

L2 MURICASTING ...ttt ettt ettt e et e et e s te et e e teesseebeeab e et e e st e essesbeeasebeeaseeseensesaeessesssessesssensesssenteessenrens 97
VLAN ettt ettt ettt ettt ettt et b et b e st s e st s e st ek en ek ea skt a skt es b e st be s A en et en s en e s en s s ens st et e s st be st beneesenes 97

QOS (QUANILY OF SEIVICE)......cuiiieiiieiieietee ettt ettt ettt et et st s et et e et et te s et et et esess et esesess st esess s s esessss s esesees 97
SBOUIEY ...ttt ettt ettt ettt ettt et te et e et e b e be b esbessessessessessess et s eseeseese e b e ebeeb e b e b e b eab e s b e st e st esbesteseeteeteereebeebeeaeebe b esbensents 97
MANAGEIMENT. ...ttt ettt ettt et e et et e esb e et e esseeseesseeseessesseessessse s eesaesseassesseasseseesseaseesseaseensesssensesssensesssesenssans 97
POWET SAVING ...ttt ettt bt b st bbbt b bbb st b st b e st e bt b et b et e bbbt st e bt et s bbbt ne 97

16. Appendix C —Rack mount Instructions 98
17. Appendix D-Trap Messages 99
18. Appendix E-Syslog Messages 101

Xiii



D-Link DGS-1100 Series Switch User Manual

Introduction

This manual’s command descriptions are based on the software release 1.00. The commands listed
here are the subset of commands that are supported by the DGS-1100 Series switch.

Audience

This reference manual is intended for network administrators and other IT networking professionals
responsible for managing the switch by using the Web User Interface (Web Ul). The Web Ul is the
secondary management interface to the DGS-1100 Series switch, which will be generally be referred
to simply as “the Switch” within this manual. This manual is written in a way that assumes that you
already have the experience and knowledge of Ethernet and modern networking principles for Local
Area Networks.

Other Documentation

The documents below are a further source of information in regards to configuring and
troubleshooting the switch. All the documents are available either from the CD, bundled with this
switch, or from the D-Link website. Other documents related to this switch are:

o Getting started Guide
o D-Link Network Assistant (DNA) User Guide

Conventions

Convention Description

Boldface Font Indicates a button, a toolbar icon, menu, or menu item. For example:
Open the File menu and choose Cancel. Used for emphasis. May
also indicate system messages or prompts appearing on screen.
For example: You have mail. Bold font is also used to represent
filenames, program names and commands. For example: use the
copy command.

Initial capital letter Indicates a window name. Names of keys on the keyboard have
initial capitals. For example: Click Enter.

Menu Name > Menu Indicates the menu structure. Device > Port > Port Properties

Option means the Port Properties menu option under the Port menu

option that is located under the Device menu.

Blue Courier Font This convention is used to represent an example of a screen
console display including example entries of CLI command input
with the corresponding output.
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Notes, Notices, and Cautions

Below are examples of the three types of indicators used in this manual. When administering your
switch using the information in this document, you should pay special attention to these indicators.
Each example below provides an explanatory remark regarding each type of indicator.

NOTE: A note indicates important information that helps you make better use of

i/‘
4 your device.

I]@ NOTICE: A notice indicates either potential damage to hardware or loss of data
and tells you how to avoid the problem.

‘I CAUTION: A caution indicates a potential for property damage, personal injury,
( = ) ordeath.
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2. Product Introduction

Thank you and congratulations on your purchase of D-Link DGS-1100 Series Switch Products.

D-Link's next generation DGS-1100 Series switches blends plug-and-play simplicity with exceptional
value and reliability for small and medium-sized business (SMB) networking. All models are housed
in a new style rack-mount metal case with easy-to-view front panel diagnostic LEDs.

The brand-new DGS-1100 series are born to be green by design of IEEE 802.3az Energy Efficient
Ethernet compliant (abbreviated as EEE) and D-Link Green Technologies. It allows significant power
saving during periods of low data activity. In most of use cases and environments, switches are idle
in 90% or more of time. While no traffic in a short period of time, ports on DGS-1100 switch get into
power saving mode automatically. Once if a packet is received, the switch wakes and works
immediately. Connecting to EEE compliant devices, such as PCs and servers, the network can save
energy without compromising any performance. While connecting to legacy devices which do not
support IEEE 802.3az, D-Link Green Technologies can reduce power consumption by changing the
power state of the link.

DGS-1100-16V2

16-Port 10/100/1000Mpbs Switch

Front Panel

b— b— b—3d bl { b— b b—d b= {

DGS-1100-16V2

Figure 2-1- DGS-1100-16V2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Link/Act/Speed LED (Ports 1-16):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.
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Rear Panel

SWITCH GND T

= ACLINE [ [
& GEN 100-240VAC (7, d =)
50/60Hz i 0 )

0.2A MAX || I

Power Cord Retainer

Figure 2-2 - DGS-1100-16V2 Rear Panel

Power: The power port is where to connect the AC power cord.
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DGS-1100-24V2

24-Port 10/100/1000Mpbs Switch

Front Panel

1
Chossed S Chemsd | Chonsnd' Chesnd’ | Choansnd 5 £ frend’ ! !l S Chamnd s Chumd  {mannd

? 4 | !T"r‘ Il'l'"] JERED) [ ] 4 | '}T”[."‘l IO [T

DGS-1100-24v2

Figure 2-3 — DGS-1100-24V2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Link/Act/Speed LED (Ports 1-24):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Rear Panel

SWITCH GND

ACLINE | .
] i i 100-240VAC (7=,

50/60Hz
0.3A MAX

®

Power Cord Retainer

r 0 /] )

Figure 2-4— DGS-1100-24V2 Rear Panel

Power: Connect the supplied AC power cable to this port.
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DGS-1100-24PV2

24-Port 10/100/1000Mpbs PoE Switch

Front Panel

04 107 114 127 134 14¥ 154 16V 174 18V 104 207 214 22V 234 24V

Mode  Re:
® o
DGS-1100-24PV2

Figure 2-5 — DGS-1100-24PV2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Port LED Indicator(For PoE Model):

A LED select button to switch two modes in turn for all 10/100/1000Mbps ports:

- Link/Act/Speed Mode

- PoE Mode

Link/Act/Speed LED (Ports 1-24):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

PoE Mode (Ports 1-12):

Green: PD device insert and power feeding.

Amber: PD device insert but failure occurs. (PSE can't provide power to PD due to PD error or power
budget is not enough.)

Light off: No PD device insert.

LED Mode Button: Pressing this button will change the LED behavior from Link mode and PoE
mode.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Note:The LED behavior for ports 1-12 will switch between Link mode and PoE mode when the
PoE mode is active. Port 1 ~ Port 12 PoE power budget is 30 watts/port. Total POE Power budget is
100 watts.
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Rear Panel

SWITCH GND

ACLINE
ﬁ 100-240VAC

v ‘ 0 0 ‘
@ 4
Power Cord Retainer
Figure 2-6— DGS-1100-24PV2 Rear Panel

Power: Connect the supplied AC power cable to this port.

1 CAUTION: This equipment can be connected only to PoE networks without
= routing to the outside plant.

DGS-1100-10MPV2

8 x 10/100/1000 Mbps PoE + 2 x 100/1000 Mbps SFP Switch

Front Panel

Figure 2-7 — DGS-1100-10MPV2 Front Panel

DGS-1100-10MPV2

Power LED: The Power LED lights up when the Switch is connected to a power source.
Port LED Indicator(For PoE Model):

A LED select button to switch two modes in turn for all 10/100/1000Mbps ports:

- Link/Act/Speed Mode

- PoE Mode

Link/Act/Speed LED (Ports 1-10):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

PoE Mode (Ports 1-8):

Green: PD device insert and power feeding.

Amber: PD device insert but failure occurs. (PSE can't provide power to PD due to PD error or power
budget is not enough.)

Light off: No PD device insert.
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LED Mode Button: Pressing this button will change the LED behavior from Link mode and PoE
mode.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Note:The LED behavior for ports 1-8 will switch between Link mode and PoE mode when the
PoE mode is active. Port 1 ~ Port 8 PoE power budget is 30 watts/port. Total POE Power budget is
130 watts.

Rear Panel

SWITCH GND

-)
@

Power Cord Retalner O

Figure 2-8— DGS-1100-10MPV2 Rear Panel

Power: Connect the supplied AC power cable to this port.

I CAUTION: This equipment can be connected only to PoE networks without
= routing to the outside plant.

I CAUTION: The MiniGBIC ports should use UL listed Optical Transceiver
= product, Rated Laser Class I. 3.3Vdc.

DGS-1100-10MPPV2

8 x 10/100/1000 Mbps PoE + 2 x 100/1000 Mbps SFP Switch

Front Panel

D-Link

DGS-1100-10MPPV2

Figure 2-9 — DGS-1100-10MPPV2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Port LED Indicator(For PoE Model):
A LED select button to switch two modes in turn for all 10/100/1000Mbps ports:

8
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- Link/Act/Speed Mode

- PoE Mode

Link/Act/Speed LED (Ports 1-10):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

PoE Mode (Ports 1-8):

Green: PD device insert and power feeding.

Amber: PD device insert but failure occurs. (PSE can't provide power to PD due to PD error or power
budget is not enough.)

Light off: No PD device insert.

LED Mode Button: Pressing this button will change the LED behavior from Link mode and PoE
mode.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Note:The LED behavior for ports 1-8 will switch between Link mode and PoE mode when the
PoE mode is active. Port 1 ~ Port 6 PoE power budget is 30 watts/port. Port 7 ~ Port 8 PoE power
budget is 90 watts/port. Total POE Power budget is 242 watts.

Rear Panel

{ o
()
_ ACLINE
=N s

30AMAX
e

SWITCH GND

Figure 2-10—- DGS-1100-10MPPV2 Rear Panel

Power: Connect the supplied AC power cable to this port.

CAUTION: This equipment can be connected only to PoE networks without

( ! 5 routing to the outside plant.
A

CAUTION: The MiniGBIC ports should use UL listed Optical Transceiver
product, Rated Laser Class I. 3.3Vdc.

DGS-1100-26MPV2

24 x 10/100/1000 Mbps PoE + 2 x 100/1000 BASE-T/SFP Combo Switch

9
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Front Panel

DGS-1100-26MPVZ

Figure 2-11 — DGS-1100-26MPV2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Port LED Indicator(For PoE Model):

A LED select button to switch two modes in turn for all 10/100/1000Mbps ports:

- Link/Act/Speed Mode

- PoE Mode

Link/Act/Speed LED (Ports 1-26):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

PoE Mode (Ports 1-24):

Green: PD device insert and power feeding.

Amber: PD device insert but failure occurs. (PSE can't provide power to PD due to PD error or power
budget is not enough.)

Light off: No PD device insert.

LED Mode Button: Pressing this button will change the LED behavior from Link mode and PoE
mode.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Note:The LED behavior for ports 1-24will switch between Link mode and PoE mode when the
PoE mode is active. Port 1 ~ Port 24 PoE power budget is 30 watts/port. Total POE Power budget is
370 watts.

Rear Panel

@ .
| ‘1:‘57\ | L N | @

& (@

Figure 2-12— DGS-1100-26MPV2 Rear Panel

Power: Connect the supplied AC power cable to this port.

10
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CAUTION: This equipment can be connected only to PoE networks without
routing to the outside plant.

CAUTION: The MiniGBIC ports should use UL listed Optical Transceiver
product, Rated Laser Class I. 3.3Vdc.

DGS-1100-26 MPPV2

24 x 10/100/1000 Mbps PoE + 2 x 100/1000 BASE-T/SFP Combo Switch

Front Panel

DGS-1100-26MPFV2

Figure 2-13 — DGS-1100-26MPPV2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Port LED Indicator(For PoE Model):

A LED select button to switch two modes in turn for all 10/100/1000Mbps ports:

- Link/Act/Speed Mode

- PoE Mode

Link/Act/Speed LED (Ports 1-26):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

PoE Mode (Ports 1-24):

Green: PD device insert and power feeding.

Amber: PD device insert but failure occurs. (PSE can't provide power to PD due to PD error or power
budget is not enough.)

Light off: No PD device insert.

LED Mode Button: Pressing this button will change the LED behavior from Link mode and PoE
mode.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Note:The LED behavior for ports 1-24will switch between Link mode and PoE mode when the
PoE mode is active. Port 1 ~ Port 20 PoE power budget is 30 watts/port. Port 21 ~ Port 24 PoE
power budget is 90 watts/port. Total POE Power budget is 525 watts.

11
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Rear Panel

SWITGH GND

Figure 2-14— DGS-1100-26MPPV2 Rear Panel

Power: Connect the supplied AC power cable to this port.

CAUTION: This equipment can be connected only to PoE networks without

( ! 5 routing to the outside plant.
AN

CAUTION: The MiniGBIC ports should use UL listed Optical Transceiver
product, Rated Laser Class I. 3.3Vdc.

DGS-1100-18PV2

16*10/100/1000M PoE + 2 x 100/1000 BASE-T/SFP Combo Switch

Front Panel

94 107" 11A 12¥ 134 14¥ 154

D-Li i H

_ DGS-1100-18PV2

Figure 2-15 — DGS-1100-18PV2 Front Panel

Power LED: The Power LED lights up when the Switch is connected to a power source.
Port LED Indicator(For PoE Model):

A LED select button to switch two modes in turn for all 10/100/1000Mbps ports:

- Link/Act/Speed Mode

- PoE Mode

Link/Act/Speed LED (Ports 1-18):

Solid Green: When there is a secure 1000Mbps connection at the port.

Blinking Green or Amber: When there is reception or transmission occurring at the port.
Solid Amber: When there is a secure 10/100Mbps connection at the port.

Light off: No link.

PoE Mode (Ports 1-16):

Green: PD device insert and power feeding.

Amber: PD device insert but failure occurs. (PSE can't provide power to PD due to PD error or power
budget is not enough.)

Light off: No PD device insert.

12
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LED Mode Button: Pressing this button will change the LED behavior from Link mode and PoE
mode.

Reset: By pressing the Reset button until the all port LED turns amber, the Switch will
change back to the default configuration and all changes will be lost.

Note:The LED behavior for ports 1-16will switch between Link mode and PoE mode when the
PoE mode is active. Port 1 ~ Port 16 PoE power budget is 30 watts/port. Total POE Power budget is
130 watts.

Rear Panel

@ @)
SWITCH GND
AC LINE

g
® |

Power Cord Retalner O

Figure 2-16— DGS-1100-18PV2 Rear Panel

Power: Connect the supplied AC power cable to this port.

‘I CAUTION: This equipment can be connected only to PoE networks without
= routing to the outside plant.

‘I CAUTION: The MiniGBIC ports should use UL listed Optical Transceiver
= product, Rated Laser Class I. 3.3Vdc.

13
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Hardware Installation

This chapter provides unpacking and installation information for the D-Link Switch.

Step1: Unpacking

Open the shipping carton and carefully unpack its contents. Please consult the packing list located in
the User Manual to make sure all items are present and undamaged. If any item is missing or
damaged, please contact your local D-Link reseller for replacement.

Packing contents of DGS-1100-16V2 /24V2
124PV2/10MPV2/10MPPV2/26 MPV2/26 MPPV2/18PV
2

One D-Link DGS-1100 Series Switch
AC power cord

Four rubber feet

Screws and two mounting brackets
One accessory kit for a ground screw
One Getting Started Guide

If any item is found missing or damaged, please contact the local reseller for replacement.

Step2: Switch Installation

For safe switch installation and operation, it is recommended that you:

e Visually inspect the power cord to see that it is secured fully to the AC power connector.
o Make sure that there is proper heat dissipation and adequate ventilation around the switch.
e Do not place heavy objects on the switch.

Desktop or Shelf Installation

When installing the switch on a desktop or shelf, the rubber feet included with the device must be
attached on the bottom at each corner of the device’s base. Allow enough ventilation space between
the device and the objects around it.

14
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Figure 3-1 — Attach the adhesive rubber pads to the bottom

Rack Installation

The switch can be mounted in an EIA standard size 19-inch rack, which can be placed in a wiring
closet with other equipment. To install, attach the mounting brackets to the switch’s side panels (one
on each side) and secure them with the screws provided (please note that these brackets are not

designed for palm size switches).

Figure 3-2 — Attach the mounting brackets to the Switch

Then, use the screws provided with the equipment rack to mount the switch in the rack.

Figure 3-3— Mount the Switch in the rack or chassis

Please be aware of following safety Instructions when installing:

A) Elevated Operating Ambient - If installed in a closed or multi-unit rack assembly, the operating
ambient temperature of the rack environment may be greater than room ambient. Therefore,
consideration should be given to installing the equipment in an environment compatible with the
maximum ambient temperature (Tma) specified by the manufacturer.

15
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B) Reduced Air Flow - Installation of the equipment in a rack should be such that the amount of air
flow required for safe operation of the equipment is not compromised.

C) Mechanical Loading - Mounting of the equipment in the rack should be such that a hazardous
condition is not achieved due to uneven mechanical loading.

D) Circuit Overloading - Consideration should be given to the connection of the equipment to the
supply circuit and the effect that overloading of the circuits might have on overcurrent protection and
supply wiring. Appropriate consideration of equipment nameplate ratings should be used when
addressing this concern.

E) Reliable Earthing - Reliable earthing of rack-mounted equipment should be maintained. Particular
attention should be given to supply connections other than direct connections to the branch circuit
(e.g. use of power strips)."

Step 3 - Plugging in the AC Power Cord

Users may now connect the AC power cord into the rear of the switch and to an electrical outlet
(preferably one that is grounded and surge protected).

Figure 3-4 — Plugging the switch into an outlet

Power Failure

As a precaution, the switch should be unplugged in case of power failure. When power is resumed,
plug the switch back in.

Grounding the Switch

This section describes how to connect the DGS-1100 Series Switch to ground. You must complete
this procedure before powering your switch.

Required Tools and Equipment

e Ground screws (included in the accessory kit): One M4 x 6 mm (metric) pan-head screw

e Ground cable (not included in the accessory kit): The grounding cable should be sized
according to local and national installation requirements. Depending on the power supply
and system, a 12 to 6 AWG copper conductor is required for U.S installation. Commercially
available 6 AWG wire is recommended. The length of the cable depends on the proximity of
the switch to proper grounding facilities.

e A screwdriver (not included in the accessory Kkit)

The following steps let you connect the switch to a protective ground:

Step 1: Verify if the system power is off.

16
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Step 2: Use the ground cable to place the #8 terminal lug ring on top of the ground-screw opening,
as seen in the figure below.

Step 3: Insert the ground screw into the ground-screw opening.
Step 4: Using a screwdriver, tighten the ground screw to secure the ground cable to the switch.

Step 5: Attach the terminal lug ring at the other end of the grounding cable to an appropriate
grounding stud or bolt on rack where the switch is installed.

Step 6: Verify if the connections at the ground connector on the switch and the rack are securely
attached.

@
oUW
g @
SWTEH GRD
Ground catis — — b ¥ = - #8 Tarminal kg #ing L

Figure 3-5 — Ground cable, screw and #8 terminal lug rings

17
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Web-based Switch Configuration

Management Options

Connecting using the Web User Interface
Logging onto the Web Manager

Smart Wizard

Web User Interface (Web Ul)

Management Options

The Switch provides multiple access platforms that can be used to configure, manage and monitor
networking features available on the Switch. Currently there are three management platforms
available and they are described below.

Web-based Management Interface

After successfully installing the Switch, the user can configure the Switch, and display statistics
graphically using a Web browser, such as Microsoft® Internet Explorer, Opera Firefox, Safari, or
Google Chrome.

SNMP-based Management

The Switch can be managed with an SNMP-compatible console program. The Switch supports
SNMP version 1.0, and version 2c. The SNMP agent decodes the incoming SNMP messages and
responds to requests with MIB objects stored in the database. The SNMP agent updates the MIB
objects to generate statistics and counters.

D-Link Network Assistant

DNA (D-Link Network Assistant) is a program for discovering DGS-1100 Series Switches with the
same L2 network segment connected to your PC.

Connecting using the Web User Interface

Most software functions of the DGS-1100 Series switches can be managed, configured and
monitored via the embedded web-based (HTML) interface. Manage the Switch from remote stations
anywhere on the network through a standard web browser. The web browser acts as a universal
access tool and can communicate directly with the Switch using the HTTP or HTTPS protocol.

You need the following equipment to begin the web configuration of your device:

e A PC with a RJ-45 Ethernet connection
e A standard Ethernet cable

Figure 4-1 Connecting to a DGS-1100 Series Switch

Connect the Ethernet cable to any of the ports on the front panel of the switch and to the Ethernet
port on the PC.

18
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Logging onto the Web Manager

To access the Web User Interface, simply open a standard web browser on the management PC
and enter the Switch’s default IP address into the address bar of the browser and press the Enter

key.

‘/7/ NOTE: The default IP address of this switch is 10.90.90.90, with a subnet mask
of 255.255.255.0.

= http://10.90.80.90/ 2410.90.90.90

Figure 4-2 Display entering the IP address in Internet Explorer

This will open the user authentication window, as seen below.

User Name | admin |E||

Password

[ Lagin ] [ Reset

Figure 4-3 User Authentication window

By default, the username is “admin” and the password is also “admin”. Click the Login button.

19
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Smart Wizard

After a successfully connecting to the Web User Interface for the first time, the Smart Wizard
embedded Web utility will be launched. This wizard will guide the user through basic configuration
steps that is essential for first time connection to the Switch.

Step 1 — System IP Information

In this window, the user can configure the IP address assignment method, the static IP address,
Netmask and Gateway address.

Welcome to Wizard

The wizard will guide you to do basic configurations on 3 steps for the |IP Information, and
o Wmg SNMPUTyou are not changing the settings, click on "Exit” to go back to the main page.
e J

Step 1 of 3: The wizard will help to complete settings for System IF address, Metmask, and
Gateway.

System IP Information

‘@ Static 1 DHCP
IP Address | 10 - 90 - 90 - 90 |
Netmask | 24 (266.255.255.0)  [=]|
Gateway [ & 8 - 85 8]
[ Ignore the wizard next time Exit | | MNext

Figure 4-4 System IP Information window

The fields that can be configured are described below:

Parameter Description

Static Select this option to manually configure and use IP address
settings on this switch.

DHCP Select this option to obtain IP address settings from a DHCP
server.

IP Address Enter the IP address of the Switch here.

Netmask Select the Netmask option here.

Gateway Enter the default gateway IP address here.
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Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.

Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
ul.

Click the Next button to accept the changes made and continue to the next step.

Step 2 — Admin Password

In this window, the user can set the password used with the admin account.

Welcome to Wizard

Figure 4-5 Admin Password

Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.

Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
Ul

Click the Next button to accept the changes made and continue to the next step.
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Step 3 — SNMP Settings
In this window, the user can enable or disable the SNMP function.

Step 3 of 3: Enable SNMP for management.
o .
SNMP
SNMP 1 Enabled (@ Disabled
| Ignore the wizard next time Exit | | Back | | Apply & Save

Figure 4-6 SNMP window

The fields that can be configured are described below:

Parameter Description

SNMP Select the Enabled option to enable the SNMP function.
Select the Disabled option to disable the SNMP function.

Tick the Ignore the wizard next time option to skip the Smart Wizard on the next login.

Click the Exit button to discard the changes made, exit the Smart Wizard, and continue to the Web
Ul

Click the Apply & Save button to accept the changes made, and then continue to the Web UI.
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Web User Interface (Web Ul)

By clicking the Exit button in the Smart Wizard, you will enter the Web-based Management interface.

Areas of the User Interface

The figure below shows the user interface. Three distinct areas that divide the user interface, as
described in the table.

D-Link

Building Networks for People

% Logged in as® admin- 10.90 90100

Device Type DGS-1100-24PV2 Gigabit Ethemnet Switch MAC Address 28-30-82-00-03-88
System Name SWITCH IP Address 10.80.90.90
255.255.255.0

System Location
Contact - | 0000
o0t PROM Version Ver 141 AREA 2 fime 01/01/2000 00:01:24
Firmware Version Ver 2.00.002 123456789
Hargware Version A1

Figure 4-7 Main Web Ul window

Area Number Description

AREA 1 In this area, a folder tree layout is displayed of functions that
can be configured using the Web Ul. Open folders and click
the hyperlinked menu buttons to access each individual page
for configuration. The DGS-1100-24V2 link is the default
page that will display basic monitoring settings for this switch.

AREA 2 In this area, the Switch’s configuration page can be found,
based on the selection made in Area 1.
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System

Device Information

System Information Settings
Port Configuration

PoE (PoE Model Only)
System Log

Time

Time Range

Device Information

In this window, the Device Information is displayed. It appears automatically when you log in the
Switch. To return to the Device Information window after viewing other windows, click the DGS-

1100-24V2 link.

Device Information

Device Type DGS-1100-24V2 Gigabit Ethernet Switch MAC Address
System Name SWITCH IP Address
System Location Mask

System Contact Gateway

Boot PROM Version Ver 1.11 System Time
Firmware Version Ver 2.00.003 Serial Number
Hardware Version Al

Figure 5-1 Device Information window
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System Information Settings

System Information

The user can enter a System Name, System Location, and System Contact to aid in defining the
Switch.

To view the following window, click System > System Information Settings>System Information,
as shown below:

System Information

System Name |SWITCH |

System Location [TE chars |

System Contact {*‘*‘ e | Apply

Figure 5-2 System Information Settings window

The fields that can be configured are described below:

Parameter Description

System Name Enter a system name for the Switch, if so desired. This name
will identify it in the Switch network.

System Location Enter the location of the Switch, if so desired.

System Contact Enter a contact name for the Switch, if so desired.

Click the Apply button to accept the changes made.

IPv4 Interface

This window is used to configure the IPv4 settings of the switch.

To view the following window, click System > System Information Settings > IPv4 Interface, as
shown below:

IP Settings

Get IP From

IP Address (10 - o0 - o0 - o0
Gateway 0.0 i) 1]

DHCP Retry Time (5-120) [ tmes

Note: DHCP default retry interval- 5 seconds Apply

Figure 5-3 Peripheral Settings window

The fields that can be configured are described below:

Parameter Description

Get IP From Select DHCP to automatically obtain an IP address. Select Static to
manually configure the IP address settings.

IP Address If Static is selected, enter the IP address of the switch. If DHCP is
selected, the automatically obtained IP address will be displayed.

Mask If Static is selected, enter the IP address of the switch. If DHCP is
selected, the automatically obtained network mask will be displayed.

Gateway If Static is selected, enter the IP address of the switch. If DHCP is
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selected, the automatically obtained gateway will be displayed.

DHCP retry Time | If DHCP is selected, enter the number of times to retry obtaining an IP
address.

Click the Apply button to accept the changes made.

IPv6 Interface

This window is used to configure the IPv6 settings of the switch.

To view the following window, click System > System Information Settings > IPv6 Interface, as
shown below:

IPv6 Interface

IPvE State Disabled El

Static IPv6 Address [2013 164 [ #ppl )

Figure 5-4 Peripheral Settings window

The fields that can be configured are described below:

Parameter Description

IPv6 State Select whether to Enable or Disable IPv6 functionality.

Static IPv6 Address If enabled, enter the static IPv6 address of the switch.

Click the Apply button to accept the changes made.
Port Configuration

Port Settings(DGS-1100-
16V2/24V2/24PV2/10MPV2/10MPPV2 Only)

This window is used to view and configure the Switch’s port settings.

To view the following window, click System > Port Configuration > Port Settings, as shown below:
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Port Settings

From Port To Port State MDIX Flow Control
[etht v] [etht v [ Enabled v] [Auto | [of

Duplex Speed Description
[Auto v [ Auto v h

B

Apply

I S N Powconen T T N
ethl Down Auto of Auto Auto

Enabled

eth2 Down Enabled Auto of Auto Auto
an3 Down Enabled Auto of Auto Auto
ethd Down Enabled Auto or Auto Auto
eths Down Enabled Auto off Auto Auto
ethe Down Enabled Auto of Auto Auto
eth7 Down Enabled Auto of Auto Auto
eths Up Enabled Auto off Auto Auto
g Down Enabled Auto or Auto Auto
ein10 Down Enabled Auto ot Auto Auto

Figure 5-5 Port Settings window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

State Select this option to enable or disable the physical port here.

MDIX Select the Medium Dependent Interface Crossover (MDIX)
option here. Options to choose from are Auto, Normal, and
Cross.

Auto - Select this option for auto-sensing of the optimal type of
cabling.

Normal - Select this option for normal cabling. If this option is
selected, the port is in the MDIX mode and can be connected
to a PC’s NIC using a straight-through cable or a port (in the
MDIX mode) on another switch through a cross-over cable.

Cross - Select this option for cross cabling. If this option is
selected, the port is in the MDI mode and can be connected to
a port (in the MDIX mode) on another switch through a straight
cable.

Flow Control Select to either turn flow control On or Off here. Ports
configured for full-duplex use 802.3x flow control, half-duplex
ports use back-pressure flow control, and Auto ports use an
automatic selection of the two.

Duplex Select the duplex mode used here. Options to choose from are
Auto, Half, and Full.

Speed Select the port speed option here. This option will manually
force the connected on the selected port to only connect at the
speed specified here. Options to choose from are Auto, 10M,
100M. 1000M speed is only available when Auto is selected.

Description Enter an 8 characters description for the corresponding port
here.

Click the Apply button to accept the changes made.
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Port Settings(DGS-1100-26MPV2/26MPPV2/18PV2
Only)

This window is used to view and configure the Switch’s port settings.

To view the following window, click System > Port Configuration > Port Settings, as shown below:

Port Setfings
From Port To Port Medium Type State DX Flow Control
[eth1 ~ | [ethi ~ | [sFP ~ | [Enabled ~ | [Auio v
Duplex Speed Description
Aule v | [Aut - 5 chars | [ Apply |
[ Pot | lnkSas | Swle | MOX | lwConiol | Dupls | Swed | Doscision
ethi Down Enabied Auto o Auto Alto
eth2 Down Enabied Auto o Auto Auto
ethd Down Enabled Auto Off Auto Auto
ethd Down Enabled Auto Off Auto Auto
eths Down Enabled Auto Off Auto Auto
ethé Down Enabled Auto o Auto Auto
eth? Down Enabled Auto o Auto Auto
ethi Down Enabled Auto Off Auto Auto
ethd Down Enabied Auto Off Auto Auto
ethil Down Enabied Auto Off Auto Auto
ethil Dawn Enabled Auto Off Auto Auto
ethiz Down Enabled Alto of Auto Auto
eth13 Down Enabled Auto Off Auto Auto
ethid Down Enabled Auto of Auto Auto
ethis Down Enabled Auto o Auto Auto
ethib Down Enabled Auta of Auto Auto
ethi¥ Up Enabied Auto o Auto Alto
ethid Down Enabied Auto Off Auto Auto
eth19 Down Enabled Auto Off Auto Auto
eth20 Down Enabled Auto o Auto Auto
eth21 Down Enabled Auto of Auto Auto
2th22 Down Enabled Auto Off Auto Auto
eth23 Down Enabled Auto Off Auto Auto
eth2d Down Enabled Auto Off Auto Auto
eth25(C) Down Enabied Auta o Auto Alto
eth25(F) Down Enabied Auto o Full Auto
eth26(C) Down Enabled Auto Off Auto Auto
eth26(F) Down Enabled Auto Off Full Auto

Figure 5-6 Port Settings window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.
Media Type Select the port media type here. Options to choose from are

Auto, RJ45, and SFP. Selecting the SFP option includes the
use of SFP+ transceivers for 10G connectivity.

State Select this option to enable or disable the physical port here.

MDIX Select the Medium Dependent Interface Crossover (MDIX)
option here. Options to choose from are Auto, Normal, and
Cross.

Auto - Select this option for auto-sensing of the optimal type of
cabling.

Normal - Select this option for normal cabling. If this option is
selected, the port is in the MDIX mode and can be connected
to a PC’s NIC using a straight-through cable or a port (in the
MDIX mode) on another switch through a cross-over cable.

Cross - Select this option for cross cabling. If this option is
selected, the port is in the MDI mode and can be connected to
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a port (in the MDIX mode) on another switch through a straight
cable.

Flow Control Select to either turn flow control On or Off here. Ports
configured for full-duplex use 802.3x flow control, half-duplex
ports use back-pressure flow control, and Auto ports use an
automatic selection of the two.

Duplex Select the duplex mode used here. Options to choose from are
Auto, Half, and Full.

Speed Select the port speed option here. This option will manually
force the connected on the selected port to only connect at the
speed specified here. Options to choose from are Auto, 10M,
100M. 1000M speed is only available when Auto is selected.

Description Enter an 8 characters description for the corresponding port
here.

Click the Apply button to accept the changes made.

Port Status(DGS-1100-
16V2/24V2/24PV2/10MPV2/10MPPV2 Only)

This window is used to view the Switch’s port status.

To view the following window, click System > Port Configuration > Port Status, as shown below:

ol [ATU!

Port Status
I S T e R = N NS
eth1 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0:0:0:0
eth2 Mot-Connected 1 Disabled Auto Auto 1000BASE-T 0000
eth3 Not-Connected 1 Disabled Auto Auto 1000BASE-T oooo
ethd Not-Connected 1 Disabled Auto Auto 1000BASE-T oo
eths Not-Connected 1 Disabled Auto Auto 1000BASE-T oo
ethg Not-Connected 1 Disabled Auta Auto 1000BASE-T [ EbEY]
eth? Not-Connected 1 Disabled Auto Auto 1000BASE-T oooo
eths Not-Connected 1 Disabled Auto Autto 1000BASE-T 0000
ethg Not-Connected 1 Disabled Auto Auto 1000BASE-T 0000
eth10 Not-Connected 1 Disabled Auto Auto 1000BASE-T o:ooo
eth11 Not-Connected 1 Disabled Auto Auto 1000BASE-T oo
eth12 Mot-Connected 1 Disabled Auta Auto 1000BASE-T oo
eth13 Not-Connected 1 Disabled Auto Auto 10DOBASE-T o000
eth14 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0000
eth15 Not-Connected 1 Disabled Auto Auto 1D00BASE-T o000
eth16 Not-Connected 1 Disabled Auta Auto 1000BASE-T 0000
eth17 Not-Connected 1 Disabled Auto Auto 10D0BASE-T 0000
eth1s Not-Connected i Disabled Auto Auto 1000BASE-T 0:0:0:0
eth19 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0:0:0:0
eth20 Mot-Caonnected 1 Disabled Auto Auto 1000BASE-T o000
eth21 Not-Connected 1 Disabled Auto Auto 10D0BASE-T 0:0:0:0
eth22 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0:0:0:0

Figure 5-7 Port Status window

Port Status(DGS-1100-26MPV2/26MPPV2/18PV2
Only)

This window is used to view the Switch’s port status.

To view the following window, click System > Port Configuration > Port Status, as shown below:
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Port Status
I B S S S S BN
ethd Not-Connected 1 Disabled Auto Auto 1000BASE-T 0.0:00
eth9 Not-Connected 1 Disabled Auto Auto “1000BASE-T 0:0:00
eth10 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0.0:00
eth11 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0:0:00
eth12 Not-Connected A Disabled Auto Aute 1000BASE-T 0:0:00
eth13 Not-Connected A Disabled Auto Auto. “1000BASE-T 0.0:00
eth14 Not-Connected il Disabled Auto Auto 1000BASE-T 0000
eth15 Not-Gonnected 1 Disabled Auto Auto 1000BASE-T 00:00
eth16 Not-Connected 1 Disabled Auto Auto “1000BASE-T 0000
eth17 Not-Connected 1 Disabled Auto Auto “1000BASE-T 00:00
eth1g Not-Gonnected 1 Disabled Auto Auto 1000BASE-T 0.0:00
eth19 Not-Connected 1 Disabled Auto Auto “1000BASE-T 0000
eth20 Not-Connected ‘| Disabled Auto Auto 1000BASE-T 0000
eth21 Not-Connected A Disabled Auto Auto. “1000BASE-T 0000
eth22 Not-Connected 1 Disabled Auto Auto 1000BASE-T 0000
eth23 Connected 1 Disabled Auto-Full Auto-100M 1000BASE-T 0:05:55
eth24 Not-Connected 1 Disabled Auto Auto “1000BASE-T 0000
eth25(C) Not-Connected 1 Disabled Auto Auto “1000BASE-T 00:00
eth25(F) Not-Connected 1 Disabled Auto Auto SFP 0.0:00
eth26(C) Not-Connected 1 Disabled Auto Auto “1000BASE-T 0000
&th26(F) Not-Connected A Disabled Auto Auto SFP 0000

Figure 5-8 Port Status window

Jumbo Frame

This window is used to view and configure the Jumbo Frame settings. The Switch supports jumbo
frames. Jumbo frames are Ethernet frames with more than 1,518 bytes of payload. The Switch
supports jumbo frames with a maximum frame size of up to 10240 bytes.

To view the following window, click System > Port Configuration > Jumbo Frame, as shown below:

Jumbo Frame

Frame State Enabled @ Disabled

Note:Maximum frame length is 10240 bytes if enabled Apply

Figure 5-9 Jumbo Frame window

The fields that can be configured are described below:

Parameter Description

Frame State Select whether to Enable or Disable support for Jumbo
Frames on the switch.

Click the Apply button to accept the changes made.
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PoE (PoE Model Only)

The DGS-1100 PoE Model switch supports Power over Ethernet (PoE) as defined by the IEEE
802.3af and 802.3at.DGS-1100 MPP series also support the IEEE 802.3bt standard.

The ports and power ratings per switch are as follows:

Switch Model Port Numbers Power Rating
DGS-1100-10MPV2 1-8 30w
DGS-1100-10MPPV2 1-8 30W

7-8 90w
DGS-1100-26MPV2 1-24 30w
DGS-1100-26MPPV2 1-24 30w
21-24 90w
DGS-1100-24PV2 1-12 30W
DGS-1100-18PV2 1-16 30W

Ports can be supplied at 48 VDC power to Powered Devices (PDs) over Category 5 or Category 3
UTP Ethernet cables. The Switch follows the standard PSE (Power Sourcing Equipment) pinout
Alternative A, whereby power is sent out over pins 1, 2, 3 and 6. The Switches work with all D-Link
802.3af capable devices.

The Switch includes the following PoE features:

e Auto-discovery recognizes the connection of a PD (Powered Device) and automatically sends
power to it.

e The Auto-disable feature occurs under two conditions: firstly, if the total power consumption
exceeds the system power limit; and secondly, if the per port power consumption exceeds the
per port power limit.

e Active circuit protection automatically disables the port if there is a short. Other ports will remain

active.
Based on 802.3af/at PDs receive power according PSE provides power according to the following
to the following classification: classification:
0 12.95W 0 16.2W
1 3.84W 1 4.2W
2 6.49W 2 7.4W
3 12.95W 3 16.2W
4 25.5W 4 31.6W
PoE System

This window is used to configure the PoE system and display the detailed power information and
PoE Trap parameters for PoE modules.

To view the following window, click System > PoE > PoE System, as shown below:
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PoE System
Usage Threshold (1-99) Trap State
= % | Disabled =] Apply
Fowe g o ol 4 oo s
100 0o 99 Disabled

Figure 5-10 PoE System window

The fields that can be configured are described below:

Parameter Description

Usage Threshold Enter the usage threshold to generate a log and send the
corresponding standard notification.

Trap State Select this option to enable or disable the sending of PoE
notifications.

Click the Apply button to accept the changes made.

PoE Status

This window displays the PoE status of each port.

To view the following window, click System > PoE > PoE Status, as shown below:

ol tatu

PoE Status
I S S O T S
eihl Searching NIA 0.0 0.0
eth2 Searching NIA 0.0 0.0
eth3 Searching NIA 0.0 0.0
ethd Searching NIA 0.0 0.0
eths Searching NIA 00 0.0
etht Searching NFA 0.0 0.0
eth7 Searching NIA 0.0 0.0
ethd Searching NIA 0.0 0.0
ethg Searching NIA 0.0 0.0
eth10 Searching NFA 0.0 0.0
ethi1 Searching NIA 0.0 0.0
eth12 Searching NIA 0.0 0.0
eth13 Searching NIA 0.0 0.0
ethi4 Searching NIA 0.0 0.0
eth15 Searching NIA 0.0 0.0
eth16 Searching NIA 0.0 0.0
eth17 Searching NIA 0.0 0.0
eth13 Searching NIA 0.0 0.0
eth19 Searching N/A 0.0 0.0
eth2d Searching NIA 0.0 0.0
eth21 Searching NIA 0.0 0.0
eth22 Searching NIA 0.0 0.0

Figure 5-11 PoE Status window

Note: For the PoE Status table, if the classification was shown as “Legacy PD”, it will be classified
to non-AF PD or Legacy PD.
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PoE Configuration(DGS-1100-
24PV2/10MPV2/26MPV2/18PV2 Only)

This window is used to configure the PoE port.

To view the following window, click System > PoE > PoE Configuration, as shown below:

PoE Configuration
From Port To Port Priority State Power Limit Max Wattage(1000-30000)
|eth1 E‘ | ethi |z|| | Low |z|| | Disabled E“ ‘ Auto |z” 1 milliwatts
Time Range
- ——
I S R T . S R
eth1 Enabled Low 30000
eth2 Enabled Low 30000
eth Enabled Low 30000
ethd Enabled Low 30000
eths Enabled Low 30000
eth6 Enabled Low 30000
eth? Enabied Low 30000
ethg Enabled Low 30000
ethg Enabled Low 30000
eth1D Enabled Low 30000
eth!y Enabled Low 30000
eth12 Enabled Low 30000

Figure 5-12 PoE Configuration window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Priority Select the priority for provisioning power to the port. Options
to choose from are Critical, High and Low.

State Select this option to enable or disable the PoE functionality.

Power Limit Select the power management mode for the PoE ports.
Options to choose from are Auto, Class 1, Class 2, Class 3,
and Class 4.

Max Wattage When selecting Auto in the Mode drop-down list, this option

appears. Tick the check box and enter the maximum wattage
of power that can be provisioned to the auto-detected PD. If
the value is not entered, the class of the PD automatically
determines the maximum wattage which can be provisioned.
The valid range for maximum wattage is between 1000 mW
and 30000 mW.

Time Range Select the Time Range from the drop-down list.

Note: The Time Range drop down menu will only have
available options if a time profile has been created.

Click the Delete Time Range button to clear the setting in the corresponding Time Range field.

Click the Apply button to accept the changes made.

Note: The Max Wattage option will only be available if the check box next to the input field is
enabled. When enabled, the Power Limit drop down menu will not be available.

Note: If the switch failed to supply power to the IEEE 802.3at PD (Powered Device),
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1.Check if the PD connected to the port supports the IEEE 802.3at standard.

2.Manually configure the corresponding port’s power limit value to 30 Watts.

PoE Configuration(DGS-1100-10MPPV2/26MPPV2
Only)

This window is used to configure the PoE port.

To view the following window, click System > PoE > PoE Configuration, as shown below:

PoE Configuration

From Port To Port Priorty State 4-Pair State Power Limit Max Wattage (1000-30000)

‘elhﬂ ﬂ| ‘etm ﬂ| |Low ﬂ‘ ‘ Disabled ﬂ| | Disabled v] ‘Auto ﬂ| D‘ millwatts
Time Range
e 5]
I S N B T ™ S S
eth1 Enabled Disabled 65535 Delete Time Range
eth2 Enabled Disabled 65535
eth3 Enabled Disabled 65535
ethd Enabled Disabled 65535
eth Enabled Disabled 65535
ethg Enabled Disabled 65535

eth? Enabled Disabled 6553500 D
ethg Enabled Disabled 6553500 Delete Time Range

Figure 5-13 PoE Configuration window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Priority Select the priority for provisioning power to the port. Options
to choose from are Critical, High and Low.

State Select this option to enable or disable the PoE functionality.

4-Pair State Select the power management mode for the PoE ports.
Options to choose from are Disable, 60W Enabled, 90W
Enabled.

Power Limit Select the power management mode for the PoE ports.

Options to choose from are Auto, Class 1, Class 2, Class 3,
and Class 4. (When 4-Pair State is enabled, Power Limit is
Auto always.)

Max Wattage When selecting Auto in the Mode drop-down list, this option
appears. Tick the check box and enter the maximum wattage
of power that can be provisioned to the auto-detected PD. If
the value is not entered, the class of the PD automatically
determines the maximum wattage which can be provisioned.
The valid range for maximum wattage is between 1000 mW
and 30000 mW.

Time Range Select the Time Range from the drop-down list.

Note: The Time Range drop down menu will only have
available options if a time profile has been created.

Click the Delete Time Range button to clear the setting in the corresponding Time Range field.

Click the Apply button to accept the changes made.
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Note: The Max Wattage option will only be available if the check box next to the input field is
enabled. When enabled, the Power Limit drop down menu will not be available.

Note: If the switch failed to supply power to the IEEE 802.3at PD (Powered Device),
1.Check if the PD connected to the port supports the IEEE 802.3at standard.

2.Manually configure the corresponding port’s power limit value to 30 Watts.
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PD Alive

This window is used to configure the PoE port.

To view the following window, click System > PoE > PD Alive, as shown below:

PD Alive Configuration

From Port To Port PDAlive State PD IP Address

[etn1 [7] [etnt [] [Disabled[=] [ . |

Poll Interval (10-300) Retry Count (0-5) Waiting Time (30-300) Action

'FD | set P ‘ |9'J ‘ sec | Both E” ’W|

I S T 2 B L
eth1 Disabled 0.0.0.0 an 2 90 Both
eth2 Disabled 0.0.0.0 an 2 g0 Both
eth3 Disabled 0.0.0.0 an 2 90 Both
eth4 Disabled 0.00.0 an 2 50 Both
eths Disabled 0.000 3o 2 90 Both
ethé Disabled 0.0.0.0 30 2 90 Both
eth? Disabied 0.0.0.0 an 2 90 Both
ethd Disabled 0.0.0.0 30 2 50 Both
ethd Disabled 0.0.00 an 2 90 Baoth
eth10 Disabled 0.0.00 3o = 90 Baoth
eth11 Disabled 0.0.0.0 an o 20 Both
eth12 Disabled 0.0.0.0 an 2 950 Both
eth13 Disabled 0.0.0.0 an 2 90 Both
eth14 Disabled 0.0.00 30 2 90 Baoth
eth1s Disabied 0.0.00 30 £ 90 Both
eth16 Disabled 0.0.0.0 30 2 90 Both

Figure 5-14 PD Alive window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

PD Alive State Select to enable or disable the state of the PoE alive function
on the specified port(s) here.

PD IP Address Enter the IPv4 address of the target PD here.

Poll Interval (10-300) Enter the poll interval value here. The range is from 10 to

300 seconds. This is the interval at which ping requests will
be sent to the target PD to check the status.

Retry Count (0-5) Enter the retry count value here. The range is from 0 to 5.
This is the amount of times that the ping request will be
resend if the target PD does not respond.

Waiting Time (30-300) Enter the waiting time value here. The range is from 30 to
300 seconds. This is the time the Switch will wait for the PD
to recover from rebooting.

Action Select the action that will be taken here. Options to choose
from are:

* Reset - Specifies to reset the PoE port state.

* Notify - Specifies to send logs and traps to notify the
administrator.

* Both - Specifies to send logs and traps and then to reset
the PoE port state.

Click the Apply button to accept the changes made.
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System Log

System Log Settings

This window is used to view and configure the system’s log settings.

To view the following window, click System > System Log > System Log Settings, as shown
below:

Global State

System Log ‘ Disabled E| Apply |
Buffer Log Settings
Buffer Log State Enabled E| Apply

Figure 5-15 System Log Settings window

The fields that can be configured for Global State are described below:

Parameter Description

System Log Select this option to enable or disable the System Log
functionality.

Click the Apply button to accept the changes made.

The fields that can be configured for Buffer Log Settings are described below:

Parameter Description

Buffer Log State Select whether the enable or disable the buffer log’s global
state here. Options to choose from are Enable, Disabled.

Click the Apply button to accept the changes made.

System Log Server Settings

This window is used to view and configure system log’s server settings.

To view the following window, click System > System Log > System Log Server Settings, as
shown below:

Log Server

Host IPv4 Address l:l Facility Local 0 E
UDP Port (514,1024-65535) Severity Warning [=] Apply

Figure 5-16 System Log Server Settings window
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The fields that can be configured are described below:

Parameter Description

Host IPv4 Address Enter the system log server’s IPv4 address here.

UDP Port Enter the system log server’'s UDP port number here. This
value must be between 1024 and 65535. By default, this
value is 514.

Facility Specifies an application from which system logs are sent to

the remote server. Only one facility can be assigned to a
single server. If a second facility level is assigned, the first
facility is overwritten. There are up to eight facilities can be
assigned (Local 0 to Local 7).

Severity Select the severity value of the type of information that will be
logged. Options to choose from are Warning, informational,
and All

The possible levels are:

Warning - The lowest level of a device warning. The device
is functioning, but an operational problem has occurred.

Informational - Provides device information.
All - Displays all levels of system logs.

Click the Apply button to accept the changes made.

System Log

This window is used to view and clear the system log.

To view the following window, click System > System Log > System Log, as shown below:

System Log

Clear Log

Total Entries: 0

I S T oo

Figure 5-17 System Log window

Click the Clear Log button to clear the system log entries displayed in the table.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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Time

The Simple Network Time Protocol (SNTP) is a protocol for synchronizing computer clocks through
the Internet. It provides comprehensive mechanisms to access national time and frequency
dissemination services, organize the SNTP subnet of servers and clients, and adjust the system
clock in each participant.

Clock Settings

This window is used to configure the time settings for the Switch.

To view the following window, click System > Time > Clock Settings, as shown below:

Clock Settings.

Time (HH:MM.SS) ED.D3.37 ‘
Date (DD / MM/ YYYY) 1/01/2000

Apply |

Figure 5-18 Clock Settings window

The fields that can be configured are described below:

Parameter Description

Time (HH:MM:SS) Enter the current time in hours, minutes, and seconds.

Date (DD / MM/ YYYY) Enter the current day, month, and year to update the system
clock.

Click the Apply button to accept the changes made.

Time Zone Settings

This window is used to configure time zones and Daylight Savings Time settings for SNTP.

To view the following window, click System > Time > Time Zone Settings, as shown below:

Time Zone Setfings
Summer Time State
Time Zone i} E|
Date Setting
From: Date of the Month l:l
From: Month l:l
From:Year l:l
From: Time (HH:MM) |:| |:|
To: Date of the Month l:l
To: Time (HHMM) [0 [0 [-]

[ty |

Figure 5-19 Time Zone Settings window

The fields that can be configured are described below:
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Parameter Description

Summer Time State Select the summer time setting. Options to choose from are
Disabled, and Date Setting.

Disabled - Select to disable the summer time setting.

Date Setting - Select to configure the summer time that
should start and end on the specified date.

Time Zone Select to specify your local time zone’s offset from
Coordinated Universal Time (UTC).

The fields that can be configured for Date Setting are described below:

Parameter Description

From: Date of the Month Select date of the month that summer time will start.

From: Month Select the month that summer time will start.

From: Year Enter the year that the summer time will start.

From: Time (HH:MM) Select the time of the day that summer time will start.

To: Date of the Month Select date of the month that summer time will end.

To: Month Select the month that summer time will end.

To: Year Enter the year that the summer time will end.

To: Time (HH:MM) Select the time of the day that summer time will end.

Offset Enter the number of minutes to add during summer time. The
?;Eault value is 60. The range of this offset is 30, 60, 90 and

Click the Apply button to accept the changes made.

SNTP Settings

This window is used to configure the time settings for the Switch.

To view the following window, click System > Time > SNTP Settings, as shown below:

SNTP Global Settings

Current Time Source System Clock

SNTP State Disabled [=]

Poll Interval (30-99999) o0 Jsec |
SNTP Server Setting

IPv4 Address - .

I S S A

0000

Figure 5-20 SNTP Settings window

The fields that can be configured for SNTP Global Settings are described below:

Parameter Description

SNTP State Select this option to enable or disable SNTP.

Pool Interval Enter the synchronizing interval in seconds. The value is
from 30 to 99999 seconds. The default interval is 720
seconds.

Click the Apply button to accept the changes made.
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The fields that can be configured for SNTP Server Setting are described below:

Parameter Description

IPv4 Address Enter the IP address of the SNTP server which provides the
clock synchronization.

Click the Apply button to add the SNTP server.

Click the Delete button to remove the specified entry.

Time Range

This window is used to view and configure the time range settings. The maximum number of time
profiles supported by the switch is 4.

To view the following window, click System > Time Range, as shown below:

Time Range

Range Name [ Daity
From: Week Sun =] To: Week Sun =]
From: Time (HH:MM) E To: Time (HH:MM) [ ey |

Total Entries: 0

St T T I

Figure 5-21 Time Range window

The fields that can be configured are described below:

Parameter Description

Range Name Enter the name of the time range. This name can be up to 8
characters long.

From Week / To Week Select the starting and ending days of the week that will be
used for this time range. Tick the Daily option to use this
time range for every day of the week. Tick the End Week
Day option to use this time range from the starting day of the
week until the end of the week, which is Sunday.

From Time / To Time Select the starting and ending time of the day that will be
used for this time range. The first drop-down menu selects
the hour and the second drop-down menu selects the
minute.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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Management

User Account Settings
SNMP

HTTP/HTTPS

D-Link Discovery Protocol

User Account Settings

This window is used to configure the user accounts. The active user account sessions can be
viewed.

There are several configuration options available in the Web User Interface (Web Ul). The set of
configuration options available to the user depends on the account’s Privilege Level.

‘//... . . .
NOTE: By default, the admin account is created on the Switch.

To view the following window, click Management > User Account Settings, as shown below:

User Accou Setting

User Accounts Settings

User Name Password Apply
Total Entries: 1
S S A S R

admin Read-Write

Figure 6-1 User Management Settings window

The fields that can be configured are described below:

Parameter Description
User Name Select the user account name here.
Password Enter the password for the account here.

Click the Apply button to accept the changes made.
Click the Delete button to remove the specified user account entry.

Note: Only one user can be logged into the switch at any time.
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SNMP

Simple Network Management Protocol (SNMP) is an OSI Layer 7 (Application Layer) designed
specifically for managing and monitoring network devices. SNMP enables network management
stations to read and modify the settings of gateways, routers, switches, and other network devices.
Use SNMP to configure system features for proper operation, monitor performance and detect
potential problems in the Switch, switch group or network.

Managed devices that support SNMP include software (referred to as an agent), which runs locally
on the device. A defined set of variables (managed objects) is maintained by the SNMP agent and
used to manage the device. These objects are defined in a Management Information Base (MIB),
which provides a standard presentation of the information controlled by the on-board SNMP agent.
SNMP defines both the format of the MIB specifications and the protocol used to access this
information over the network.

The Switch supports the SNMP versions 1, and 2c. The two versions of SNMP vary in the level of
security provided between the management station and the network device.

In SNMP v.1 and v2c, user authentication is accomplished using ‘community string’, which function
like passwords. The remote user SNMP application and the Switch SNMP must use the same
community string. SNMP packets from any station that has not been authenticated are ignored
(dropped).

Traps

Traps are messages that alert network personnel of events that occur on the Switch. The events can
be as serious as a reboot (someone accidentally turned OFF the Switch), or less serious like a port
status change. The Switch generates traps and sends them to the trap recipient (or network
manager). Typical traps include trap messages for Authentication Failure, and Topology Change.

MIBs

The Switch in the Management Information Base (MIB) stores management and counter information.
The Switch uses the standard MIB-1l Management Information Base module. Consequently, values
for MIB objects can be retrieved from any SNMP-based network management software. In addition
to the standard MIB-II, the Switch also supports its own proprietary enterprise MIB as an extended
Management Information Base. Specifying the MIB Object Identifier may also retrieve the proprietary
MIB. MIB values can be either read-only or read-write.

The Switch supports the Simple Network Management Protocol (SNMP) versions 1, and 2c. The
administrator can specify the SNMP version used to monitor and control the Switch.

SNMP settings are configured using the menus located on the SNMP folder of the Web manager.
Workstations on the network that are allowed SNMP privileged access to the Switch can be
restricted with the Management Station IP Address menu.
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SNMP Global Settings

This window is used to configure the SNMP global settings and trap settings.

To view the following window, click Management > SNMP > SNMP Global Settings, as shown
below:

SNMP Global Settings

SNMP Global State Enabled @ Disabled
Trap Settings

Trap Global State Enabled @ Disabled
"] SNMP Authentication Trap
7] Port Link Up
| Part Link Down
[ Coldstart

[] Warmstart Apply

Figure 6-2 SNMP Global Settings window

The fields that can be configured for SNMP Global Settings are described below:

Parameter Description

SNMP Global State Select this option to enable or disable the SNMP feature.

The fields that can be configured for Trap Settings are described below:

Parameter Description

Trap Global State Select this option to enable or disable the sending of all or
specific SNMP notifications.

SNMP Authentication Trap | Tick this option to control the sending of SNMP
authentication failure notifications.

Port Link Up Tick this option to control the sending of port link up
notifications.

Port Link Down Tick this option to control the sending of port link down
notifications.

Coldstart Tick this option to control the sending of SNMP Coldstart
notifications.

Warmstart Tick this option to control the sending of SNMP Warmstart
notifications.

Click the Apply button to accept the changes made.

SNMP Community Table Settings

This window is used to create an SNMP community string to define the relationship between the
SNMP manager and an agent. The community string acts like a password to permit access to the
agent on the Switch. One or more of the following characteristics can be associated with the
community string:

e Read/write or read-only level permission for the MIB objects accessible to the SNMP community.

To view the following window, click Management > SNMP > SNMP Community Table Settings, as
shown below:
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SNMP Community Settings
Access Right Read Write E Community Name Apply \
Total Entries: 2
Read-Write private
Read-Only public

Figure 6-3 SNMP Community Table Settings window

The fields that can be configured are described below:

Parameter Description

Access Right Select the access right here. Options to choose from are
Read Only and Read Write.

Read Only - SNMP community members using the
community string created can only read the contents of the
MIBs on the Switch.

Read Write - SNMP community members using the
community string created can read from and write to the
contents of the MIBs on the Switch.

Community Name Enter an alphanumeric string of up to 16 characters that is
used to identify members of an SNMP community. This
string is used like a password to give remote SNMP
managers access to MIB objects in the Switch’s SNMP
agent.

Click the Apply button to accept the changes made.

SNMP Host Table Settings

This window is used to configure and display the recipient of the SNMP notification.

To view the following window, click Management > SNMP > SNMP Host Table Settings, as shown
below:

SNMP Host Settings

User-based Security Model SNMPv1 |z|
Community String o chars Apply
Host IP Address SNMP Version ‘Community String I

Figure 6-4 SNMP Host Table Settings

The fields that can be configured are described below:

Parameter Description

Host IPv4 Address Enter the IPv4 address of the SNMP noatification host.
User-based Security Select the security model here. Options to choose from are
Model SNMPv1, and SNMPv2c.

SNMPv1 - Select to allow the group user to use the SNMPv1
security model.

SNMPv2c - Select to allow the group user to use the
SNMPv2c security model.

Community String Enter the community string to be sent with the notification
packet.
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Click the Apply button to accept the changes made.

HTTP/HTTPS

This window is used to configure Web settings on the Switch.
To view the following window, click Management > HTTP/HTTPS, as shown below:

HTTPHTTPS

\Web Session @ HTTP 7 HTTPS

\Web Session Timeout (60-36000) 1200 SeC Apply ‘

Figure 6-5 HTTP/HTTPS window

The fields that can be configured for HTTP/HTTPS Settings are described below:

Parameter Description
Web Session Select this option to enable the configuration through HTTP
or HTTPS.

Note: When switching from HTTP to HTTPS mode, the
switch will take about 30 seconds to initialize the secured
HTTP environment.

Web Session Timeout Enter a value for the amount of time in seconds before the
web session expires.

Click the Apply button to accept the changes made.

Note: If the switch is in HTTPS mode, the firmware or configuration cannot be upgraded using
regular HTTP.

D-Link Discovery Protocol

This window is used to configure and display D-Link Discovery Protocol (DDP).

To view the following window, click Management > D-Link Discovery Protocol, as shown below:

D-Link Discovery Protocol
DDP Global Settings
D-Link Discovery Profocol State @ Enabled ) Disabled
DDP Port Settings
From Port eth1 E To Port eth El State Disabled E [ Apply \
TS S————————
et Enabled
eth2 Enabled
eth3 Enabled
ethd Enabled
sih5 Enabled
etht Enabled
eih? Enabled
ethg Enabled
ethd Enabled

Figure 6-6 D-Link Discovery Protocol window

The fields that can be configured for D-Link Discovery Protocol are described below:
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Parameter Description

D-Link Discovery Protocol | Select this option to enable or disable DDP global state.
State

Report Timer Select the interval in seconds between two consecutive DDP
report messages. Options to choose from are 30, 60, 90,120,
and Never.

Click the Apply button to accept the changes made.
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L2 Features

FDB

VLAN

Spanning Tree
Loopback Detection
Link Aggregation

L2 Multicast Control
LLDP

FDB

Static FDB
Unicast Static FDB

This window is used to view and configure the static unicast forwarding settings on the Switch.

To view the following window, click L2 Features> FDB > Static FDB > Unicast Static FDB, as
shown below:

Unicast Static FDB

Port [ethi =] VID(1-4084) [ WMAC Address Aoply
Total Entries: 0 Delete All
E— e I —

Figure 7-1 Unicast Static FDB window

The fields that can be configured are described below:

Parameter Description

Port Allows the selection of the port number on which the MAC
address entered resides.

VID Enter the VLAN ID on which the associated unicast MAC
address resides.

MAC Address Enter the MAC address to which packets will be statically
forwarded or dropped. This must be a unicast MAC address.

Click the Apply button to accept the changes made.
Click the Delete All button to delete all the entries found in the display table.

Click the Delete button to remove the specified entry.
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Multicast Static FDB

This window is used to view and configure the multicast static FDB settings. To view the following
window, click L2 Features > FDB > Static FDB > Multicast Static FDB, as shown below:

Multicast Static FDB

From Port To Port VID{1-4094) MAC Address

ath = ath = I:l 01-00-5E-30(XX-XX [ Aoy |
Total Entries: 0 Delete All |
= e Fus o 1

Figure 7-2 Multicast Static FDB window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

VID Enter the VLAN ID of the VLAN the corresponding MAC
address belongs to.

MAC Address Enter the static destination MAC address of the multicast
packets. This must be a multicast MAC address. The format
of the destination MAC address is 01-XX-XX-XX-XX-XX.

Click the Apply button to accept the changes made.
Click the Delete All button to remove all the entries.

Click the Delete button to remove the specific entry.

MAC Address Table Settings

This window is used to view and configure the MAC address table’s global settings.

To view the following window, click L2 Features > FDB > MAC Address Table Settings, as shown
below:

| Global Settings MAC Address Learning

Aging Time (0, 10 - 1000000) 1300 sec
Apply

Figure 7-3 MAC Address Table Settings (Global Settings) window

The fields that can be configured are described below:

Parameter Description

Aging Time Enter the MAC address table’s aging time value here. This
value must be between 10 and 1000000 seconds. Entering 0
will disable MAC address aging. By default, this value is 300
seconds.

Click the Apply button to accept the changes made.

After clicking the MAC Address Learning tab, at the top of the page, the following page will be
available.
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Global Settings ‘ MAC Address Learning |
From Port To Port State
[eth1 =] [eth =] [ Enabled [=]
.= e Es
ethl Enabled
eth2 Enabled
etha Enabled
ethd Enabled
eths Enabled
etng Enabled
eth? Enabled
etna Enabled
ethd Enabled
etnio Enabled
ethi1 Enabled
ethiz Enabled

Figure 7-4 MAC Address Table Settings (MAC Address Learning) window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the range of ports that will be used for this
configuration here.

State Select to enable or disable the MAC address learning
function on the ports specified here.

Click the Apply button to accept the changes made.

MAC Address Table

This window is used to view the entries listed in the MAC address table.

To view the following window, click L2 Features > FDB > MAC Address Table, as shown below:

MAC Address Table

Total Entries: 1 Clear All
S o e e
1 94-05-B6-5D-2E-T9 Dynamic eth24

[3n] ElEE [

Figure 7-5 MAC Address Table window

Click the Clear All button to clear all dynamic MAC addresses.
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VLAN

VLAN Configuration Wizard

This window is used to view and configure the VLAN settings on this switch.

To view the following window, click L2 Features > VLAN > VLAN Configuration Wizard, as shown
below:

VLAN Configuration Wizard

@ Create VLAN

Configure VLAN
WVID (1-4094)
Next I

Figure 7-6 VLAN Configuration Wizard window

The fields that can be configured for VLAN Configuration Wizard are described below:

Parameter Description
Create VLAN VID Create VLAN ID
Configure VLAN VID Configure VLAN ID

Click the Next button to accept the changes made.

This window is used to create the VLAN on this switch.

Create VLAN
VLAN ID 2
| Pt | seectAl [ ]2[3]s]s5]6]7aofaoln]2][13]14]15]16][17]18]10]20]21]22[23] 2]
Tagged All @ @ @ @l @) INENENEN @ @ @) INENE
Untagged All # # @ 9 # @ 9 F E e E = B » E = B »
Not Member 9 @ @ e @ e 0 e e e @ @ B @ ° e © @ © @ @ @ © @
Native VLAN (PVID) L T S O S I R TR A
VLAN Mode H H H H HHUHWHHHHH H H H H H H H H H H H H

A-Access; H-Hybrid; T-Trunk
Note: The selected member port(s) will be mandatory configured to Hybird mode.

Access Mode: The port will be an untagged member of VLAN
Trunk Mode: The port is either a tagged port or an untagged member port of it's nafive VLAN and can be a tagged member of ofher VLANS configured
Hybrid Mode: The port can be an uniagged or a tagged member of all VAN configured

[view aliowed viaN [ Back I Apply

Figure 7-7 VLAN Configuration Wizard window

The fields that can be configured for VLAN Configuration Wizard are described below:

Parameter Description

VLAN ID Create VLAN VID
VLAN Name VLAN Group name

Click the Apply button to accept the changes made.

802.1Q VLAN

This window is used to view and configure the VLAN settings on this switch.
To view the following window, click L2 Features > VLAN > 802.1Q VLAN, as shown below:
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80 G VLAN
802.1Q VLAN
VID List (2-4094) i [_amoly ][ Delete |

VLAN List

Total Entries: 1
I T S T T
1 VLANDOD1 elhi-eth24 ¢
(Al (== 6 G

Figure 7-8 802.1Q VLAN window

The fields that can be configured for 802.1Q VLAN are described below:

Parameter Description
VID List Enter the VLAN ID list that will be created here.

Click the Apply button to accept the changes made.
Click the Edit button to re-configure the specific entry.
Click the Delete button to remove the specific entry.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.

Management VLAN

This window is used to configure the Management VLAN function.

To view the following window, click L2 Features > VLAN > Management VLAN, as shown below:

Management VLAN Settings

Management VLAN State (©y Enabled (@) Disabled

Note: When 802.1Q Management VLAN is enabled, the 802.1Q VLAN should be enabled first

Figure 7-9 Management VLAN Settings window

The fields that can be configured are described below:

Parameter Description

Management VLAN State Select this option to enable or disable the Management
VLAN function.

VID VLAN VID is a unique number (between 1 and 4094) that
identifies a particular VLAN.

Click the Apply button to accept the changes made.

Asymmetric VLAN

This window is used to configure the asymmetric VLAN function.

To view the following window, click L2 Features > VLAN > Asymmetric VLAN, as shown below:

Asymmetric VLAN

Asymmetric VLAN State (Enabled (g Disabled Apply

Figure 7-10 Asymmetric VLAN window
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The fields that can be configured are described below:

Parameter Description

Asymmetric VLAN State Select this option to enable or disable the asymmetric VLAN
function

Click the Apply button to accept the changes made.

VLAN Interface

This window is used to view and configure VLAN interface settings.

To view the following window, click L2 Features > VLAN > VLAN Interface, as shown below:

VLA L

| VLAN Interface Settings | Port Summary
I s
ath Hybrid Enable Admit All VLAN Detail
&th2 Hybrid Enable Admit All
eth3 Hybrid Enable Admit All
athd Hybrid Enable Admit All
eths Hybrid Enable Admit All
ethé Hybrid Enable Admit All
th? Hybrid Enable Admit All
etha Hybrid Enable Admit All
ethd Hybrid Enable Admit Al
eth1D Hybrid Enable Admit All VLAN Detail
sth11 Hybrid Enable Admit Al
eth12 Hybrid Enable Admit All
eth13 Hybrid Enable Admit All
sihl4 Hybrid Enable Admit All VLAN Detail

Figure 7-11 VLAN Interface window

Click the View Detail button to view more detailed information about the VLAN on the specific
interface.

Click the Edit button to re-configure the specific entry.

After clicking the VLAN Detail button, the following page will appear.

VLAN Interface Information
Port eth1
VLAN Mode Hybrid
Native WLAN 1
Hybrid Untagged VLAN 1,
Hybrid Tagged VLAN -
Ingress Checking Enabled
Acceptable Frame Type Admit All

Figure 7-12 VLAN Interface Information window

More detailed information about the VLAN of the specific interface is displayed.

Click the Back button to return to the previous window.
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After the Edit button is clicked, the following window will appear. This is a dynamic window that will
change when a different VLAN Mode was selected. When Access was selected as the VLAN Mode,
the following page will appear.

Configure VLAN Interface

Fort ethl Clone

VLAN Mode Access A From Port To Port
Acceptable Frame Untagged Only i ethl T
Ingress Checking s Enabled () Disabled

<<Back Apply

Figure 7-13 Configure VLAN Interface - Access window

The fields that can be configured are described below:

Parameter Description

VLAN Mode Select the VLAN mode option here. Options to choose from
are Access, Hybrid, and Trunk.

Acceptable Frame Select the acceptable frame behavior option here. Options to
choose from are Tagged Only, Untagged Only, and Admit
All.

Ingress Checking Select this option to enable or disable the ingress checking

function. When ingress checking is enabled, the packet will
be dropped if the received port is not member port of the
VLAN classified for the received packet.

VID Enter the VLAN ID used for this configuration here. This
value must be between 1 and 4094.

From Port / To Port Select the appropriate port range used for the Clone
configuration here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

When Hybrid was selected as the VLAN Mode, the following page will appear.

Configure VLAN Interface

Port eth1 Clone

VLAN Mode [Hybia =] From Port To Port

ccastate Fras ETTR—
Ingress Checking ® Enabled () Disabled

VID(1-4094) [ ]

Action

Allowed VLAN Range [

<<Back || A_DDiY

Figure 7-14 Configure VLAN Interface - Hybrid window

The fields that can be configured are described below:

Parameter Description

VLAN Mode Select the VLAN mode option here. Options to choose from are
Access, Hybrid, and Trunk.

Acceptable Frame Select the acceptable frame behavior option here. Options to
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choose from are Tagged Only, Untagged Only, and Admit All.

Ingress Checking

Select this option to enable or disable the ingress checking
function. When ingress checking is enabled, the packet will be
dropped if the received port is not member port of the VLAN
classified for the received packet.

VID Enter the VLAN ID used for this configuration here. This value
must be between 1 and 4094.
Action Select the action that will be taken here. Options to choose from

are Remove, Tagged, and Untagged.

Allowed VLAN Range

Enter the allowed VLAN range information here.

From Port / To Port

Select the appropriate port range used for the Clone configuration
here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

When Trunk is selected as the VLAN Mode, the following page will appear.

Configure VLAN Interface

Port ethl

Clone

VLAN Mode (Tunk 7] From Port To Port
Ingress Checking * Enabled Disabled

Action All \d

Allowad VLAN Range O

'7 <<Back Apply

Figure 7-15 Configure VLAN Interface - Trunk window

The fields that can be configured are described below:

Parameter Description

VLAN Mode

Select the VLAN mode option here. Options to choose from
are Access, Hybrid, and Trunk.

Acceptable Frame

Select the acceptable frame behavior option here. Options to
choose from are Tagged Only, Untagged Only, and Admit
All.

Ingress Checking

Select this option to enable or disable the ingress checking
function. When ingress checking is enabled, the packet will
be dropped if the received port is not member port of the
VLAN classified for the received packet.

Action

Select the action that will be taken here. Options to choose
from are Remove, Tagged, and Untagged.

Allowed VLAN Range

Enter the allowed VLAN range information here.

From Port / To Port

Select the appropriate port range used for the Clone
configuration here.

Click the Apply button to accept the changes made.

Click the Back button to return to the previous window.

Note: In VLAN Mode, when a port is set to access mode, this port will be untagged member of the

access VLAN configured for the port.
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When a port is set to hybrid mode, the port can be untagged or tagged member of all VLANs
configured by the user.

When a port is set to trunk mode, this port is either tagged or untagged member port of its native
VLAN and can be tagged member of other VLANs configured by the user. The purpose of a trunk
port is to support the switch-to-switch connection.

Auto Surveillance VLAN

Auto Surveillance Properties

This window is used to configure the auto surveillance VLAN global settings and display the ports
surveillance VLAN information.

To view the following window, click L2 Features > VLAN > Auto Surveillance VLAN > Auto
Surveillance Properties, as shown below:

Global Settings

Surveillance VLAN Enabled @ Disabled

Surveillance VLAN ID (2-4094)
Surveillance VLAN CoS 5 =]
Aging Time (1-65535) f20 |min

| Apply

Note: Surveiliance VLAN ID and Voice VLAN |D can not be the same.

Figure 7-16 Auto Surveillance Properties window

The fields that can be configured for Global Settings are described below:

Parameter Description

Surveillance VLAN Select this option to enable or disable the surveillance VLAN
state
Surveillance VLAN ID Enter the surveillance VLAN ID. The range is from 2 to 4094.

Surveillance VLAN CoS Select the priority of the surveillance VLAN from 0 to 7.

Aging Time Enter the aging time of surveillance VLAN. The range is from
1 to 65535 minutes. The default value is 720 minutes. The
aging time is used to remove a port from surveillance VLAN
if the port is an automatic surveillance VLAN member. When
the last surveillance device stops sending traffic and the
MAC address of this surveillance device is aged out, the
surveillance VLAN aging timer will be started. The port will
be removed from the surveillance VLAN after expiration of
surveillance VLAN aging timer. If the surveillance traffic
resumes during the aging time, the aging timer will be reset
and stop.

Click the Apply button to accept the changes made.
MAC Settings and Surveillance Device

This window is used to configure the user-defined surveillance device OUI and display the
surveillance VLAN information.

To view the following window, click L2 Features > VLAN > Auto Surveillance VLAN > MAC
Settings and Surveillance Device, as shown below:
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User-defined MAC Setting | Auto Surveillance VLAN Summary

To add more device(s) for Auto Surveillance VLAN by user-defined configuration as below.

Component Type | Video Management Server [~] Description
MAC Address 0-01-02-03-00-00 Mask FF-FF-FF-00-00-00
Total Entries: 12

1 D-Link Device IP Surveillance Device 28-10-78-00-00-00 FF-FF-FF-FO-00-00
2 D-Link Device IP Surveillance Device 28-10-78-10-00-00 FF-FF-FF-FO-00-00
3 D-Link Device IP Surveillance Device 28-10-78-20-00-00 FF-FF-FF-FO-00-00
4 D-Link Device IP Surveillance Device B0-C5-54-00-00-00 FF-FF-FF-FO-00-00
5 D-Link Device IP Surveillance Device B0-C5-54-10-00-00 FF-FF-FF-FO-00-00
6 D-Link Device IP Surveillance Device B0-C5-54-20-00-00 FF-FF-FF-F0-00-00
7 D-Link Device IP Surveillance Device B0-C5-54-30-00-00 FF-FF-FF-F0-00-D0
: D-Link Device IP Surveillance Device B0-C5-54-40-00-00 FF-FF-FF-F0-00-00
g D-Link Device IP Surveillance Device BO-C5-54-50-00-00 FF-FF-FF-FD-00-00
10 D-Link Device IP Surveillance Device B0-C5-54-60-00-00 FF-FF-FF-FO-00-00
11 D-Link Device IP Surveillance Device B0-C5-54-70-00-00 FF-FF-FF-FD-00-00
12 D-Link Device IP Surveillance Device F0-7B-68-D0-00-00 FF-FF-FF-FO-80-00

Figure 7-17 User -defined MAC Settings window

The fields that can be configured are described below:

Parameter Description

Component Type Select the surveillance component type. Options to choose
from are Video Management Server, VMS Client/Remote
Viewer, Video Encoder, Network Storage, and Other IP
Surveillance Device.

Description Enter the description for the user-defined OUI with a
maximum of 8 characters.

MAC Address Enter the OUI MAC address.

Mask Enter the OUI MAC address matching bitmask.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

After clicking the Auto Surveillance VLAN Summary tab, the following page will appear.

User-defined MAC Setting | Auto Surveillance VLAN Summary |

Total Entries: 0

oo s

Figure 7-18 Auto Surveillance VLAN Summary window
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Voice VLAN

Voice VLAN Global

Voice VLAN is a VLAN used to carry voice traffic from IP phone. Because the sound quality of an IP
phone call will be deteriorated if the data is unevenly sent, the quality of service (QoS) for voice
traffic shall be configured to ensure the transmission priority of voice packet is higher than normal
traffic.

The switches determine whether a received packet is a voice packet by checking its source MAC
address. If the source MAC addresses of packets comply with the organizationally unique identifier
(OUI) addresses configured by the system, the packets are determined as voice packets and
transmitted in voice VLAN.

To view the following window, click L2 Features > VLAN > Voice VLAN > Voice VLAN Global, as
show below:

Voice VLAN Global

Voice VLAN State () Enabled @) Disabled

Voice VLAN 1D {2-4094) [

Aging Time (1-65535) 720 min
Apply
Note: Surveillance VLAN 1D and Voice VLAN ID can not be the same.

Figure 7-19 Voice VLAN Global window

The fields that can be configured are described below:

Voice VLAN State Select this option to enable or disable the voice VLAN.
Voice VLAN ID Enter the voice VLAN ID. The value is range from 2 to 4094.
Voice VLAN CoS Select the priority of the voice VLAN from 0 to 7.

Aging Time Enter the aging time of surveillance VLAN. The range is

from 1 to 65535 minutes. The default value is 720 minutes.
The aging time is used to remove a port from voice VLAN if
the port is an automatic VLAN member. When the last voice
device stops sending traffic and the MAC address of this
voice device is aged out, the voice VLAN aging timer will be
started. The port will be removed from the voice VLAN after
expiration of voice VLAN aging timer. If the voice traffic
resumes during the aging time, the aging timer will be reset
and stop.

Click the Apply button to accept the changes made for each individual section.
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Voice VLAN Port

This window is used to configure the user-defined voice traffic’s port.

To view the following window, click L2 Features > VLAN >Voice VLAN > Voice VLAN OUI, as
show below:

Voice VLAN Port
From Port To Port State Mode
[etn1 =] [eth1 =] [Disabled  [=] [ | Apply
) e —
etht Disable Auto Untagged
eth2 Disable Auto Untagged
eth3 Disable Auto Untagged
ethd Disable Auto Untagged
eths Disable Auto Untagged
ethé Disable Auto Untagged
eth? Disable Auto Untagged
ethd Disable Auto Untagged
athd Disable Auto Untagged
eth10 Disable Auto Untagged
efhit Disable Auto Untagged
efhi2 Disable Auto Untagged

Figure 7-20 Voice VLAN Port window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the range of ports that will be used for this
configuration here.

State Select this option to enable or disable the Voice VLAN state
of the port.
Mode Choose the Voice VLAN mode for the port. This can be Auto

untagged, Auto Tagged, or Manually configured.

Click the Apply button to accept the changes made.
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Voice VLAN OUI

This window is used to configure the user-defined voice traffic’s OUI. The OUI is used to identify the
voice traffic. There are a number of pre-defined OUIls. The user can further define the user-defined
OUls if needed. The user-defined OUI cannot be the same as the pre-defined OUI.

To view the following window, click L2 Features > VLAN >Voice VLAN > Voice VLAN OUI, as
show below:

Voice VLAN QUI
OUI Address Mask Description
poorezooooo0 | [eerermomo | [_aeoy |
Total Entries: 8
I S S R
00-01-£3-00-00-00 FF-FFFF-00-00-00 Seemens Delet
00-03-68-00-00-00 FF-FF-FF-00-00-00 Ciseo
00-08-6E-00-00-00 FF-FF-FF-00-00-00 Avaya
00-0F E2-00.00-00 FF-FF-FE-00.00.00 Hua 3C0M
00-60-B9-00-00-00 FF-FF-FF-00-00-00 NEC/Phil
00-D0-1E-00-00-00 FF-FF-FF-00-00-00 Pingtel
00-£0-75-00-00-00 FF-FFFF-00-00-00 Veritel
00-E0-BB-00-00-00 FF-FF-FF-00-00-00 3com

Figure 7-21 Voice VLAN OUI window

The fields that can be configured are described below:

Parameter Description

OUI Address Enter the OUI MAC address.

Mask Enter the OUI MAC address matching bitmask.

Description Enter the description for the user-defined OUI with a maximum of 8
characters.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.

Voice VLAN Device

This window is used to show voice devices that are connected to the ports. The start time is the time
when the device is detected on this port, the activate time is the latest time saw the device sending
the traffic.

To view the following window, click L2 Features > VLAN >Voice VLAN > Voice VLAN Device, as
show below:

I Device

Voice VLAN Device Table

Total Entries: 0

I s v s s e

Figure 7-22 Voice VLAN Device window
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Spanning Tree

This Switch supports two versions of the Spanning Tree Protocol: 802.1D-1998 STP, 802.1D-2004
Rapid STP. 802.1D-1998 STP will be familiar to most networking professionals. However, since
802.1D-2004 RSTP has been recently introduced to DGS-1100 switches, a brief introduction to the
technology is provided below followed by a description of how to set up 802.1D-1998 STP, 802.1D-
2004 RSTP.

802.1D-2004 Rapid Spanning Tree

Rapid Spanning Tree Protocol (RSTP) as defined by the IEEE 802.1D-2004 specification and a
version compatible with the IEEE 802.1D-1998 STP. RSTP can operate with legacy equipment
implementing IEEE 802.1D-1998; however, the advantages of using RSTP will be lost.

The IEEE 802.1D-2004 Rapid Spanning Tree Protocol (RSTP) evolved from the 802.1D-1998 STP
standard. RSTP was developed in order to overcome some limitations of STP that impede the
function of some recent switching innovations, in particular, certain Layer 3 functions that are
increasingly handled by Ethernet switches. The basic function and much of the terminology is the
same as STP. Most of the settings configured for STP are also used for RSTP. This section
introduces some new Spanning Tree concepts and illustrates the main differences between the two
protocols.

Edge Port

The edge port is a configurable designation used for a port that is directly connected to a segment
where a loop cannot be created. An example would be a port connected directly to a single
workstation. Ports that are designated as edge ports transition to a forwarding state immediately
without going through the listening and learning states. An edge port loses its status if it receives a
BPDU packet, immediately becoming a normal spanning tree port.

Note: If Spanning Tree protocol is used, loopback detection will not be available. If Loopback
Detection is enabled, the Spanning Tree protocol will not be available.
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STP Global Settings

This window is used to view and configure the STP global settings.

To view the following window, click L2 Features > Spanning Tree > STP Global Settings, as
shown below:

Spanning Tree State

Spanning Tree State Enabled @ Disabled Apply

Spanning Tree Mode

Spanning Tree Mode @ RSTP STP Apply

STP Traps

STP New Root Trap Enabled @) Disabled
STP Topology Change Trap Enabled @) Disabled Apply

Root Bridge Information

Root Bridge 0-00:00:00:00:00:00
Root Cost 0
Root Maximum Age 0
Root Forward Delay 0
Root Port 0

Figure 7-23 STP Global Settings window

The field that can be configured for Spanning Tree State is described below:

Parameter Description
Spanning Tree State Select this option to enable or disable the STP global state
here.

Click the Apply button to accept the changes made.

The fields that can be configured for Spanning Tree Mode are described below:

Parameter Description

Spanning Tree Mode Select the STP mode used here. Options to choose from are
RSTP, and STP.

Click the Apply button to accept the changes made.

The fields that can be configured for STP Traps are described below:

Parameter Description

STP New Root Trap Select this option to enable or disable the STP new root trap
option here.

STP Topology Change Select this option to enable or disable the STP topology

Trap change trap option here.

Click the Apply button to accept the changes made.

STP Port Settings

This window is used to view and configure the STP port settings.

To view the following window, click L2 Features > Spanning Tree > STP Port Settings, as shown
below:
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STP Port Settings
From Port To Port Port Fast
et [e]
[ Aeply |

e sun
eth1 Edge Link down
eth2 Edge Link down
eth3 Edge Link down
ethd Edge Link down
eths Edge Link down
ethé Edge Link down
eth? Edge Link down
ethd Edge Link down
etha Edge Link down
eth1d Edge Link down
eth11 Edge Link down
eth12 Edge Link down

Figure 7-24 STP Port Settings window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Port Fast Select the port fast option here. Options to choose from are

Network, Disabled, and Edge. In the Network mode the
port will remain in the non-port-fast state for three seconds.
The port will change to the port-fast state if no BPDU is
received and changes to the forwarding state. If the port
received the BPDU later, it will change to the non-port-fast
state. In the Disable mode, the port will always be in the
non-port-fast state. It will always wait for the forward-time
delay to change to the forwarding state. In the Edge mode,
the port will directly change to the spanning-tree forwarding
state when a link-up occurs without waiting for the forward-
time delay. If the interface receives a BPDU later, its
operation state changes to the non-port-fast state. By default,
this option is Edge.

Click the Apply button to accept the changes made.

Loopback Detection

The Loopback Detection (LBD) function is used to detect the loop created by a specific port. This
feature is used to temporarily shut down a port on the Switch when a CTP (Configuration Testing
Protocol) packet has been looped back to the Switch. When the Switch detects CTP packets
received from a port, this signifies a loop on the network. The Switch will automatically block the port
and send an alert to the administrator. The Loopback Detection port will restart (change to normal
state) when the Loopback Detection Recover Time times out. The Loopback Detection function can
be implemented on a range of ports at a time. The user may enable or disable this function using the
drop-down menu.

To view the following window, click L2 Features > Loopback Detection, as shown below:
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Loopback Detection Global Settings

Loopback Detection () Enabled @ Disabled

The fields that can be configured for Loopback Detection Global Settings are described below:

Parameter

Time Interval (5-300) 1o sec
Recover Time (0, 10-600) o sec
Loopback Detecfion Trap (") Enabled (o Disabled
e —
Loopback Detection Port Settings
From Port To Port State
[ath1 =] [eth1 =] [ Enabled =] [ Acoy |
I S N
ethl Enabled Normal
eth2 Enabled Normal
eth3 Enabled Normal
ethd Enabled Normal
eths Enabled Normal
ethé Enabled Normal
eth? Enabled Normal
ethd Enabled Normal

Figure 7-25 Loopback Detection window

Description

Loopback Detection

Select to enable or disable loopback detection. The default is
Disabled.

Time Interval

Set a Loop detection Interval between 7 and 32767 seconds.
The default is 70 seconds.

Recover Time

Time allowed (in seconds) for recovery when a Loopback is
detected. The Loop Detection Recover Time can be set at 0
seconds, or 60 to 1000000 seconds. Entering 0 will disable
the Loop Detection Recover Time. The default is 60 seconds.

Loopback Detection Trap

Select to enable or disable the loopback detection trap state.

Click the Apply button to accept the changes made.

The fields that can be configured for Loopback Detection Port Settings are described below:

Parameter

Description

From Port/ To Port

Select the appropriate port range used for the configuration
here.

State

Select this option to enable or disable the state of the port.

Click the Apply button to accept the changes made.

Note: If Spanning Tree protocol is used, loopback detection will not be available. If Loopback
Detection is enabled, the Spanning Tree protocol will not be available.
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Link Aggregation

Understanding Port Trunk Groups

Port trunk groups are used to combine a number of ports together to make a single high-bandwidth
data pipeline.

An Example of Link Aggregation

Ethemet Backbone
Uplink

1000 Mbps Connection 1000 Mbps Conmection 1000 Mbps Connection

< <

&

| &

End Station Clients

Figure 7-26 Example of Port Trunk Group

The Switch treats all ports in a trunk group as a single port. Data transmitted to a specific host
(destination address) will always be transmitted over the same port in a trunk group. This allows
packets in a data stream to arrive in the same order they were sent.

Link aggregation allows several ports to be grouped together and to act as a single link. This gives a
bandwidth that is a multiple of a single link's bandwidth.

Link aggregation is most commonly used to link a bandwidth intensive network device or devices,
such as a server, to the backbone of a network.

All of the ports in the group must be members of the same VLAN, and their STP status, static
multicast, traffic control; traffic segmentation and 802.1p default priority configurations must be
identical. Further, the LACP aggregated links must all be of the same speed and should be
configured as full duplex.

Load balancing is automatically applied to the ports in the aggregated group, and a link failure within
the group causes the network traffic to be directed to the remaining links in the group.
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The Spanning Tree Protocol will treat a link aggregation group as a single link, on the switch level.
On the port level, the STP will use the port parameters of the Master Port in the calculation of port
cost and in determining the state of the link aggregation group. If two redundant link aggregation
groups are configured on the Switch, STP will block one entire group; in the same way STP will
block a single port that has a redundant link.

This window is used to view and configure the link aggregation settings.

Q// NOTE: If any ports within the trunk group become disconnected, packets
‘ intended for the disconnected port will be load shared among the other linked
by ports of the link aggregation group.

the following window, click L2 Features > Link Aggregation, as shown below:

Channel Group Information

From Port To Port Group ID (1-8) Mode

[eth1 =] [eth? =] | On Add ] [Delete Member Port
Note: Each Channel Group supports up tp 8 member ports. Up to 8 Channel Groups.
Total Entries: 0

T e s ors I

Figure 7-27 Link Aggregation window

The fields that can be configured for Channel Group Information are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Group ID Enter the channel group number here. The system will

automatically create the port-channel when a physical port
first joins a channel group. An interface can only join one
channel-group.

Mode Select the mode option here. Options to choose from are On,
Active, and Passive. If the mode On is specified, the
channel group type is static. If the mode Active or Passive is
specified, the channel group type is LACP. A channel group
can only consist of either static members or LACP members.
Once the type of channel group has been determined, other
types of interfaces cannot join the channel group.

Active - Active LACP ports are capable of processing and
sending LACP control frames. This allows LACP compliant
devices to negotiate the aggregated link so the group may be
changed dynamically as needs require. In order to utilize the
ability to change an aggregated port group, that is, to add or
subtract ports from the group, at least one of the participating
devices must designate LACP ports as active. Both devices
must support LACP.

Passive - LACP ports that are designated as passive cannot
initially send LACP control frames. In order to allow the
linked port group to negotiate adjustments and make
changes dynamically, one end of the connection must have
"active" LACP ports

Click the Add button to add a new entry based on the information entered.

Click the Delete Member Port button to remove the specific member port.
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6// NOTE: Modules that support LACP:Port Settings, D-Link Discovery Protocol,
FDB, VLAN Configuration Wizard, 8021Q VLAN, Port-based VLAN, VLAN
Interface, MAC Settings and Surveillance Device, Voice VLAN Port, Voice
VLAN Device, Spanning Tree, Loopback Detection, Link Aggregation, IGMP
Snooping Groups Settings, LLDP Neighbor Port Information, Traffic
Segmentation and Mirror Settings.

View the following window, click L2 Features > Link Aggregation>Add, as shown below:

Channel Group Information

From Port To Port Group ID (1-8) Mode
ethl E| eth2 ﬂ| add HDe\ete Member Pﬂﬂi

Note: Each Channel Group supports up to 8 member poris. Up to 8 Channel Groups.

Total Entries: 1

T T T s pors =
port channel 1 eth1.eth2 Delete Channel||Channel Detail

View the following window, click L2 Features > Link Aggregation>Add>Channel Detail, as shown
below:

Port Channel Information

Port Channel 1
Proiocol LACP

Port Channel Detail Information

“ Working Mode LACP State Port Priority Port Number

Active
ath2 Active down 128 Vs

Port Channel Neighbor Information

“ Pariner System ID Partner PoriNo Partner Working Mode Partner Port Priority

0,00-00-00-00-00-00
B_ﬁ’IZ 0,00-00-00-00-00-00 0 o
LACP State:
bndl: Port is attached to an aggregater and bundied with other ports.
No-bndl: Port is in blocking state.
hot-sby- Port is in a hot-standby state
down: Port is down.

L2 Multicast Control

IGMP Snooping

Internet Group Management Protocol (IGMP) snooping allows the Switch to recognize IGMP queries
and reports sent between network stations or devices and an IGMP host.

IGMP Snooping Settings

To view the following window, click L2 Features > L2 Multicast Control >IGMP Snooping > IGMP
Snooping Settings, as shown below:
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Global Settings

Global State 7) Enabled (@) Disabled Apply

VLAN Status Settings

VID(1-4094) | () Enabled () Disabled Apply

VLAN Querier Status Settings

VID(1-4084) ) Enabled () Disabled Apply
IGMP Snooping Table

Total Entries: 1

e T e T aw  owae |
1

VLANDOD1 Disabled Disabled

L

Figure 7-28 IGMP Snooping Settings window

The field that can be configured for Global Settings is described below:

Parameter Description
Global State Select this option to enable or disable IGMP snooping global
state.

Click the Apply button to accept the changes made.
The fields that can be configured for VLAN Status Settings are described below:

Parameter Description

VID Enter a VLAN ID from 1 to 4094 and select to enable or
disable IGMP snooping on the VLAN.

Click the Apply button to accept the changes made.

The fields that can be configured for VLAN Querier Status Settings are described below:

Parameter Description

VID Enter a VLAN ID from 1 to 4094 and select to enable or
disable IGMP snooping on the VLAN.

Enter a page number and click the Go button to navigate to a specific page when multiple pages
exist.
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IGMP Snooping Groups Settings

This window is used to configure and view the IGMP snooping static group, and view IGMP
snooping group.

To view the following window, click L2 Features > L2 Multicast Control >IGMP Snooping > IGMP
Snooping Groups Settings, as shown below:

IGMP Snooping Static Groups Settings

VID (1-4094) Group Address From Port To Port
[ | [ = = & | [eth2 =] [ath2 [=] [ apply ][ Dpeete |

Total Entries: 0
IGMP Snooping Groups Table

Total Entries: 0

T o s e

Note: Mark the route port with the [*] symbol

Figure 7-29 IGMP Snooping Groups Settings

The fields that can be configured for IGMP Snooping Static Groups Settings are described below:

VID Enter a VLAN ID of the multicast group.

Group Address Enter an IP multicast group address.

From Port / To Port ﬁelect the appropriate port range used for the configuration
ere.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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Multicast Filtering

This window is used to view and configure the Layer 2 multicast filtering settings.

To view the following window, click L2 Features > L2 Multicast Control > Multicast Filtering, as
shown below:

Multicast Filtering

Muiticast Filtering Mode ‘@ Forward Unregistered =) Filter Unregistered Apply

Figure 7-30 Multicast Filtering window

The fields that can be configured are described below:

Parameter Description

Multicast Filter Mode Select the multicast filter mode here. Options to choose from
are Forward Unregistered, and Filter Unregistered. \When
selecting the Forward Unregistered option, registered
multicast packets will be forwarded based on the forwarding
table and all unregistered multicast packets will be flooded
based on the VLAN domain. When selecting the Filter
Unregistered option, registered packets will be forwarded
based on the forwarding table and all unregistered multicast
packets will be filtered.

Click the Apply button to accept the changes made.
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LLDP

LLDP Global Settings

LLDP (Link Layer Discovery Protocol) provides IEEE 802.1AB standards-based method for switches
to advertise themselves to neighbor devices, as well as to learn about neighbor LLDP devices.

This window is used to configure the LLDP global settings.
To view the following window, click L2 Features > LLDP > LLDP Global Settings, as shown below:

LLDP Global Settings

LLDP State (") Enabled (@) Disabled

LLDP Trap State ") Enabled (@ Disabled Apply J

Figure 7-31 LLDP Global Settings window

The fields that can be configured for LLDP Global Settings are described below:

Parameter Description

LLDP State Select this option to enable or disable the LLDP feature

LLDP Trap State Select this option to enable or disable the LLDP trap state.

Click the Apply button to accept the changes made.

LLDP Neighbor Port Information

This window is used to display the information learned from the neighbors. The switch receives
packets from a remote station but is able to store the information as local.

To view the following window, click L2 Features > LLDP >LLDP Neighbor Port Information, as
show below:

LLDP Neighbor Port Brief Table

Total Entries: 0

m Chassis ID Subtype Chassis 1D Port ID Subtype m Port Description

Figure 7-32 LLDP Neighbor Port Information window
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Quality of Service (QoS)

802.1p Priority
Port Rate Limiting

802.1p Priority

This window is used to view and configure the port’s default CoS settings.

To view the following window, click QoS > 802.1p Priority, as shown below:

Port Scheduler Method
From Port To Port Scheduler Method
eth1 ‘ eth1 E“ sp ‘ # WRR: queueD:queue:queue2:queue:queued:queucs:queuct:queue?=1:2:3:4:56.7:8 Apply |
Port Default CoS
From Port To Port Default CoS
Eim—c C— e
802.1p Priority Table
202 1p priority 0 1 2 3 4 5 6 7
queue2 queued queuet queued queusd queues queLes queueT
Somseriens E—TE—
etht SP o
eih2 SP 1}
eth3 SP o
ethd SP a
eths sP o
ethd SP a
eih7 SP o
ethd 8P i}
ethd SP a
eth10 SP 1}

Figure 8-1 Port Default CoS window

The fields that can be configured for Port Scheduler Method are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Scheduler Method SP - Denoting a Strict Priority scheduling will set the highest

queue to be emptied first while the other queues will follow
the weighted round-robin scheduling scheme

WRR - Use the weighted round-robin ( WRR ) algorithm to
handle packets in an even distribution in priority classes of
service.

Click the Apply button to accept the changes made.

The fields that can be configured Port Default CoS are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Default CoS Select the default CoS option for the port(s) specified here.
The priorities are Highest, High, Medium and Low.

Click the Apply button to accept the changes made.



D-Link DGS-1100 Series Switch User Manual

Port Rate Limiting

This window is used to view and configure the port rate limiting settings.

To view the following window, click QoS > Port Rate Limiting, as shown below:

Port Rate Limiting
From Port To Port Direction Rate Limit
- [ O] [t [=] T
e g~
ethl No Limit No Limit
eth2 No Limit No Limit
eth3 No Limit No Limit
ethd No Limit No Limit
eths No Limit No Limit
ethé No Limit No Limit
eth? No Limit No Limit
ethg No Limit No Limit
ethg No Limit No Limit
eth10 No Limit No Limit
eth11 No Limit No Limit
eth12 No Limit No Limit

Figure 8-2 Port Rate Limiting window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Direction Select the direction option here. Options to choose from are

Input and Output. When Input is selected, the rate limit for
ingress packets is configured. When Output is selected, the
rate limit for egress packets is configured.

Rate Limit Select the rate limit value here.

When Direction is Input, this drop-down menu allows you to
select data rate from 16Kbps to 512Mbps.

When Direction is Output, this drop-down menu allows you
to select data rate from 16Kbps to 512Mbps.

Click the Apply button to accept the changes made.
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Security

Safeguard Engine Settings
Traffic Segmentation

Storm Control

DoS Attack Prevention Settings
Zone Defense Settings

SSL

Safeguard Engine Settings

D-Link’s Safeguard Engine is a robust and innovative technology that automatically throttles the
impact of packet flooding into the switch's CPU. This function helps protect the Smart Switch from
being interrupted by malicious viruses or worm attacks.

This window is used to view and configure the safeguard engine settings.

To view the following window, click Security > Safeguard Engine Settings, as shown below:

Safeguard Engine Settings

Safeguard Engine State Disabled E Apply

Figure 9-1 Safeguard Engine Settings window

The fields that can be configured for Safeguard Engine Settings are described below:

Parameter Description
Safeguard Engine State Select to enable or disable the safeguard engine feature
here.

Traffic Segmentation

This window is used to view and configure the traffic segmentation settings. When the traffic
segmentation forwarding domain is specified, packets received by the port will be restricted in Layer
2 packet forwarding to interfaces within the domain. When the forwarding domain of a port is empty,
Layer 2 forwarding for packets received by the port is not restricted.

To view the following window, click Security > Traffic Segmentation, as shown below:

Traffic Segmentation Settings

From Port Ta Port From Forward Port To Forward Port

- ErE—
I T S

eth2 ethf-eth24
ethd etht-eth24
ethd ethi-eth24

Add |[ Delete

eths ethi-eth24
ethé eth1-eth24
eth?. ethi-eth24
ethd ethi-eth24
ethd ethi-eth24
eth10 ethi-eth24
ethl ethi-eth24

eth12 ethi-eth24

Figure 9-2 Traffic Segmentation Settings window
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The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the receiving port range used for the configuration
here.

From Forward Port/ To Select the forward port range used for the configuration here.

Forward Port

Click the Add button to add a new entry based on the information entered.

Click the Delete button to remove an entry based on the information entered.

Storm Control

This window is used to view and configure the storm control settings. Once a packet storm has been
detected, the Switch will drop packets coming into the Switch until the storm has subsided.

To view the following window, click Security > Storm Control, as shown below:

Storm Control Port Settings
From Port To Port Type Rate Limit
[etht =] [ethi =] [None =] [NoLimt __ [=] [ Aoy ]
I e
eth1 None No Limit
eth2 None No Limit
eth3 None No Limit
ethd None No Limit
eths None No Limit
ethe None No Limit
eth? None No Limit
eths None Mo Limit
ethg None No Limit
eth1D None No Limit
eth11 None No Limit
eth12 None No Limit

Figure 9-3 Storm Control window

The fields that can be configured for Storm Control Port Settings are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

Type Select the type of storm attack that will be controlled here.
Options to choose from are Broadcast, Multicast, and
Unicast.

Rate Limit Select a data rate from 16Kbps to 512Mbps.

Click the Apply button to accept the changes made.

75



D-Link DGS-1100 Series Switch User Manual

DoS Attack Prevention Settings

This window is used to view and configure the Denial-of-Service (DoS) attack prevention settings.
The following well-known DoS types which can be detected by most switches:

e Land Attack: This type of attack involves IP packets where the source and destination
address are set to the address of the target device. It may cause the target device to reply to
itself continuously.

Blat Attack: This type of attack will send packets with the TCP/UDP source port equal to the
destination port of the target device. It may cause the target device to respond to itself.
TCP-Null: This type of attack involves port scanning by using specific packets which contain
a sequence number of 0 and no flags.

TCP-Xmas: This type of attack involves port scanning by using specific packets which
contain a sequence number of 0 and the Urgent (URG), Push (PSH), and FIN flags.

TCP SYN-FIN: This type of attack involves port scanning by using specific packets which
contain SYN and FIN flags.

TCP SYN SrcPort Less 1024: This type of attack involves port scanning by using specific
packets which contain source port 0 to 1023 and SYN flag.

Ping of Death Attack: A ping of death is a type of attack on a computer that involves
sending a malformed or otherwise a malicious ping to a computer. A ping is normally 64
bytes in size (many computers cannot handle a ping larger than the maximum IP packet size)
which is 65535 bytes. The sending of a ping of this size can crash the target computer.
Traditionally, this bug has been relatively easy to exploit. Generally, sending a 65536 byte
ping packet is illegal according to networking protocol, but a packet of such a size can be
sent if it is fragmented; when the target computer reassembles the packet, a buffer overflow
can occur, which often causes a system crash.

All Types: All of above types.

To view the following window, click Security > DoS Attack Prevention Settings, as shown below:

DoS Attack Prevention Settings

DoS Type Selection

[F]Blat Attack
[WITCP S¥YN Src Port Less 1024

ZITCP Null Scan
[¥IPing Death Attack

lLand Attack [ZITCP Xmascan
[Z[TCP SYN-FIN

ZIAll Types

Do§ Settings
State

‘D\sab\ed E”

Action

Apply |

= \

I S

Land Attack Disabled

| Drop

Action
Drop
Disabled

Blat Attack Drop

TCP Null Scan Disabled Drop

TCP Xmascan Disabled Drop
Disabled
Disabled

Disabled

TCP SYN-FIN Drop
TCP SYN Sic Poit Less 1024

Ping Death Attack

Drop
Drop

Figure 9-4 DoS Attack Prevention Settings window

The fields that can be configured for DoS Attack Prevention Settings are described below:

Parameter Description

DoS Type Selection

Tick the DoS type option that will be prevented here.

State

Select to enable or disable the DoS attack prevention
feature’s global state here.

Action

Select the action that will be taken when the DoS attack was
detected here. The only option to select here is Drop.
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Click the Apply button to accept the changes made.

Zone Defense Settings

This window is used to view and configure the Zone Defense setting.

To view the following window, click Security > Zone Defense Settings, as shown below:

Figure 9-5 Zone Defense Settings window

The fields that can be configured for Zone Defense Settings are described below:

Parameter Description
State Select to enable or disable the Zone Defense feature’s global
state here.

Click the Apply button to accept the changes made.

SSL

Secure Sockets Layer (SSL) is a security feature that will provide a secure communication path
between a host and client through the use of authentication, digital signatures and encryption.

SSL Global Settings

This window is used to view and configure the SSL feature’s global settings.

To view the following window, click Security > SSL > SSL Global Settings, as shown below:

SSL Global Settings

S8L State Enabled (@) Disabled Apply
Upgrade Certificate and key

Key 5. [ mepy |

Ceriificate A [ Apply ]

Figure 9-6 SSL Global Settings window

The fields that can be configured for SSL Global Settings are described below:

Parameter Description

SSL Status Select to enable or disable the SSL feature’s global status here.

Click the Apply button to accept the changes made.

The fields that can be configured for Upgrade Certificate and key are described below:

Parameter Description
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Key

Upgrade the key

Certificate

Upgrade the Certificate

Click the Apply button to accept the changes made.
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10. OAM

Cable Diagnostics

Cable Diagnostics

The cable diagnostics feature is designed primarily for administrators or customer service
representatives to verify and test copper cables; it can rapidly determine the quality of the cables and
the types of error.

To view the following window, click OAM > Cable Diagnostics, as shown below:

Cable Diagnostics

From Port To Port

[T
[ Glearan |
I S S T S T N
eth1 10D0BASET Link down = = Clear |
eth2 10D0BASET Link down = =
eth3 1000BASET Link down . . Clear
ethd 1000BASET Link down - =
&tns 1000BASET Link down - - [ Clear ]
&tnG 1000BASET Link down - -
eih? 1000BASET Link down - = Clear
ethd 1000BASET Link down - =
&thg 1000BASET Link down - - [ clear |
ethio 1000BASET Link down = =
ethid 10D0BASET Link down - - Clear
etn12 1000BASET Link down - -

Figure 10-1 Cable Diagnostics window

The fields that can be configured are described below:

Parameter Description
From Port / To Port Select the appropriate port range used for the configuration
here.

Click the Test button to test the specific port.
Click the Clear button to clear all the information for the specific port.

Click the Clear All button to clear all the information in this table.

Note: The Cable Diagnostics feature is only supported on the copper ports on all DGS-1100 Series
switches. Please be sure that Power Saving feature is disabled before enabling Cable Diagnostics
function.

Test Result: The description of the cable diagnostic results.

* OK means the cable is good for the connection. Short in Cable means the wires of the RJ45 cable
may be in contact somewhere.

* Open in Cable means the wires of RJ45 cable may be broken, or the other end of the cable is
simply disconnected.

* Cable Fault Distance (meters): Indicates the distance of the cable fault from the Switch port, if the
cable is less than 1 meters, it will show “0”.

79



D-Link DGS-1100 Series Switch User Manual

* Cable Length (meter): If the test result is OK and the cable length is less than 15M, then "<15M"
will be displayed. If the test result is OK and the cable length is more than 15M and less than 200m,
then the cable length will be represented by the total cable length.
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11. Monitoring

Statistics
Mirror Settings

Statistics

Port Counters

This window is used to display port counter statistics.

To view the following window, click Monitoring > Statistics > Port Counters, as show below:

Port Counters

From Port To Port [t =] [_fnd [ Refresh |
‘ Clear ‘ I Clear all ]
I S S A S N S
etni 0 o 0 [
etz 0 0 0 0
etn3 0 0 0 0
ethd 0 0 0 0
eths 0 o 0 [
etng a [ 0 0
eth7 0 [ 0 [
ethg 0 0 0 0
ethg 0 o 0 0
etnio 0 0 0 0
ethid o o 0 0
eth2 0 0 0 0

Figure 11-1 Port Counters window

The fields that can be configured are described below:

Parameter Description
From Port / To Port Select the appropriate port range used for the configuration
here.

TxOK: Number of packets transmitted successfully.
RxOK: Number of packets received successfully.
TxError: Number of transmitted packets resulting in error.

RxError: Number of received packets resulting in error

Click the Find button to locate a specific entry based on the information entered.
Click the Refresh button to refresh the display table.
Click the Clear button to clear all the information for the specific port.

Click the Clear All button to clear all the information in this table.
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Mirror Settings

This window is used to view and configure the mirror feature’s settings. The Switch allows users to
copy frames transmitted and received on a port and redirect the copies to another port. Attach a
monitoring device to the mirroring port, such as a sniffer, to view details about the packets passing
through the first port. This is useful for network monitoring and troubleshooting purposes.

To view the following window, click Monitoring > Mirror Settings, as shown below:

Mirror Settings

Port

Destraton
From Port To Port Frame Type
Source |eth2 E“ | eth2 E“ ‘ RX E”

Apply ][ Delete

Mirror Session Table

Destination port
T e

Figure 11-2 Mirror Settings window

The fields that can be configured for Mirror Settings are described below:

Parameter Description

Destination Select one destination port from drop-down menu.

Source Select From Port number and the To Port number as
source port from drop-down menu. Lastly select the Frame
Type option. Options to choose from as the Frame Type are
Both, RX, and TX. When selecting Both, traffic in both the
incoming and outgoing directions will be mirrored. When
selecting RX, traffic in only the incoming direction will be
mirrored. When selecting TX, traffic in only the outgoing
direction will be mirrored.

Click the Apply button to accept the changes made.

Click the Delete button to delete an existing mirror entry based on the information entered.
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12. Green

Power Saving
EEE

Power Saving

This window is used to configure the power saving settings of the Switch.

To view the following window, click Green > Power Saving, as shown below:

‘ Power Saving Global Settings | Power Saving Shutdown Settings

Function Version 3.0

Link Detection Power Saving Enabled @ Disabled
Scheduled Port-shutdown Power Saving (7) Enabled @ Disabled
Scheduled Hibernation Power Saving Enabled @ Disabled

Scheduled Dim-LED Power Saving ) Enabled @) Disabled Apply
Administrative Dim-LED Enabled (@ Disabled Apply
Time Profile Settings

Type Dim-LED E Time Profile Apply ] | Delete

Time Profile

Figure 12-1 Power Saving window

The fields that can be configured are described below:

Parameter Description

Link Detection Power Select this option to enable or disable the link detection
Saving state. When enabled, a port which has a link down status
will be turned off to save power to the Switch. This will not
affect the port’s capabilities when the port status is link up.

Scheduled Port-shutdown | Select this option to enable or disable applying the power

Power Saving saving by scheduled port shutdown.

Scheduled Hibernation Select this option to enable or disable applying the power
Power Saving saving by scheduled hibernation power.

Scheduled Dim-LED Power | Select this option to enable or disable applying the power
Saving saving by scheduled dimming LED’s.

Administrative Dim-LED Select this option to enable or disable the port LED function.
Type Select the type of power saving. Option to choose from is

Dim-LED or Hibernation.

Time Profile If a Time Profile was previously created, select the desired
profile from the drop-down list.

Click the Apply button to accept the changes made for each individual section.

Click the Delete button to remove the specified entry.

After clicking the Power Saving Shutdown Settings tab, the following page will appear.
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Power Saving Global Settings | Power Saving Shutdown Settings |
From Port To Port Time Profile
E— -~
Total Entries: 24
I S
ethi Delete
ens
e
a0
iz

Figure 12-2 Power Saving Shutdown Settings window

The fields that can be configured are described below:

Parameter

Description

From Port/ To Port

Select the appropriate port range used for the configuration
here.

Time Range

If a Time Profile was previously created, select the desired
profile from the drop-down list.

Click the Apply button to accept the changes made.

Click the Delete button to remove the specified entry.
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Energy Efficient Ethernet (EEE) is defined in IEEE 802.3az. It is designed to reduce the energy
consumption of a link when no packets are being sent.

To view the following window, click Green > EEE, as shown below:

12—

EEE Settings
From Port To Port State
Ex = B B T
T
eth? Disabled
eth2 Disabled
eth3 Disabled
ethd Disabled
eth5 Disabled
ethG Disabled
ethy Disabled
ethg Disabled
ethg Disabled
ethid Disabled
ethi1 Disabled
ethiz Disabled

Figure 12-3 EEE window

The fields that can be configured are described below:

Parameter Description

From Port / To Port Select the appropriate port range used for the configuration
here.

State Select this option to enable or disable the state of this feature
here.

Click the Apply button to accept the changes made.
Note: The EEE feature is only supported on the copper ports on all DGS-1100 Series switches.

85



D-Link DGS-1100 Series Switch User Manual

13. Save and Tools

Save Configuration

Firmware Information

Firmware Upgrade & Backup
Configuration Restore & Backup
Log Backup

Ping

Reset

Reboot System

Save Configuration

This window is used to save the running configuration to the start-up configuration of the Switch.
This is to prevent the loss of configuration in the event of a power failure.

To view the following window, click Save > Save Configuration, as shown below:

Save Configuration

Please press the "Apply” button to save system settings to flash. | Apply

Figure 13-1 Save Configuration window

Click the Apply button to save the configuration to the switch’s flash memory.

Firmware Information

This window is used to show firmware information.

To view the following window, click Tools > Firmware Information, as shown below:

Figure 13-2 Firmware Information window

Boot Up: Clicking the Boot Up button will set that firmware image as the active image to use upon
the next system start up.

Note: Changing the firmware only happens after the switch has been manually rebooted. In order to
boot with the newly selected firmware, make sure that the switch is rebooted.

Firmware Upgrade & Backup

Note: When upgrading the firmware on the DGS-1100 Series switch, only the image
not currently active can be upgraded. All DGS-1100 Series switches come with two
images, however only one can be active at any time. (e.g. If image 1 is currently in use,
only image 2 can be upgraded, and vice versa.)

Note: If the switch is in HTTPS mode, the firmware or configuration cannot be
upgraded using regular HTTP.
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